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บทนี้เนื้อหาจะต่อเนื่องกับบทที่ 1 คือ เป็นเป็นการออกแบบช้ินส่วน 3 มิติ ด้วยวิธีที่ได้
เคยแสดงเป็นพื้นฐานแล้วในบทที่ 1 แต่ช้ินส่วนที่น ามาแสดงวิธีการออกแบบในบทนี้จะมีความ
ซับซ้อนและล าดับข้ันตอนเพิ่มมากข้ึนโดยตัวอย่างที่น ามาแสดงได้น าตัวอย่างช้ินส่วนจริงเพื่อให้
ผู้อ่านสามารถเช่ือมโยงเนื้อหาเข้ากับลกัษณะช้ินส่วนได้ ซึ่งในแต่ละหัวข้อย่อยผู้เขียนได้สอดแทรก
ค าสั่งใหม่ๆเพิ่มข้ึนอย่างต่อเนื่องเพื่อให้ผู้อ่านได้เพิ่มพูนค าสั่งใหม่ภายในโปรแกรมให้ได้มากที่สุด
เพื่อให้เพียงพอกับการน าไปประยุกต์ใช้ในการออกแบบทางวิศวกรรมและผู้เขียนได้จัดท าวีดิโอ
ภาพเคลื่อนไหวส าหรับเพิ่มช่องทางให้สะดวกมาข้ึนส าหรับฝึกปฏิบัติโดยสามารถเข้าถึงได้ที่ 
www.engineeringksu.com ซึ่งได้แยกไว้ตามแต่ละหัวข้อ ขอให้ผู้อ่านใช้วีดิโอภาพเคลื่อนไหว
ร่วมกับหนังสือเล่มนี้จะท าให้การศึกษาเป็นไปอย่างรวดเร็วข้ึน  

แนวความคิดการออกแบบบทเรียนผู้เขียนได้บูรณาการแนวความคิดจากหนังสือ
อิเลคทรอนิคส์คู่มือการใช้โปรแกรม SolidWorks V.2017 ซึ่งหากผู้อ่านต้องการศึกษาเพิ่มเติม
สามารถค้นคว้าได้จาก Tutorial ที่มาพร้อมโปรแกรม แต่ตัวอย่างช้ินส่วนต่างๆที่น ามาประกอบ
ในบทเรียนบางส่วนได้จากการที่ผู้เขียนใช้โปรแกรม SolidWorks ช่วยในการออกแบบตัวเครื่อง
จักรในงานวิจัยของ จังหวัด  เจริญสุข และอนุวัช แสนพงษ์ (2560)  

 
 
 

ช้ินส่วนที่เหมาะสมกับวิธี Extruded Boss/Base ควรเป็นช้ินส่วนที่มีลักษณะสมมาตร
ตลอดความลึกด้านใดด้านหนึ่ง ซึ่งจะท าให้ง่ายต่อการแบ่งล าดับข้ันตอนในการข้ึนรูปแต่ละส่วน 
การแบ่งล าดับข้ันตอนการข้ึนรูปมีความส าคัญมากเนื่องจากจะส่งผลต่อเวลาในการออกแบบ

    หลักการเลือกและเขียน Part 3 มิติโดยวิธี Extruded Boss/Base 2.1 
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ช้ินส่วนน้ัน หากมีการแบ่งล าดับข้ันตอนที่ถูกต้องก็จะส่งผลให้ใช้เวลาในการออกแบบช้ินส่วนนั้น
สั้นลง แต่อย่างไรก็ตามการแบ่งล าดับข้ันตอนน้ันข้ึนกับประสบการณ์และความช านาญของแต่ละ
บุคคลไป 
 

2.2.1 หลักการเลือก Part ท่ีเหมาะสมกับวิธี Extruded Boss/Base 
หลักในการเลือก Part ที่ เหมาะสมคือการพิจารณารูปทรงช้ินส่วนที่มีลักษณะ

สมมาตรตลอดความลึกด้านใดด้านหนึ่ง ดังแสดงในรูปจะเห็นว่า ช้ินส่วนจะมีรูปทรงสมมาตร
ตลอดความลึก 

 

 
 

(ก) ไดชาร์ทรถยนต์  (ข) เครื่องปั่นไฟฟ้าแบบใช้น้ ามัน  (ค) มอเตอรเ์ครื่องซักผ้า 
 

รูปท่ี 2.1 เครื่องผลิตไฟฟ้า 
ที่มา : www.jojothai.com, 2015 

 
2.1.2 การแบ่งขั้นตอนส าหรับวิธี Extruded Boss/Base 

 

หลักในการออกแบบนั้นจะต้องพิจารณาถึงวัตถุประสงค์หลักอยู่ 2 ประการดังนี้ คือ 
1.ออกแบบโดยไม่น าไปใช้ในการจ าลองสถานการณ์ 2.ออกแบบโดยน าไปใช้ในการจ าลอง
สถานการณ์ หากต้องการออกแบบเพื่อใช้ในการจ าลองสถานการณ์สิ่งที่ส าคัญสุดคือขนาดของ
ช้ินส่วนจะต้องมีความถูกต้องตามขนาดของช้ินส่วนจริง แต่หากไม่ต้องการน าไปใช้ในการจ าลอง
สถานการณ์ขนาดของช้ินส่วนบางส่วนที่เราไม่พิจารณาให้ความส าคัญมากนักก็สามารถละเว้นไว้
ได้เพื่อให้เกิดความรวดเร็วในการออกแบบ ในตัวอย่างนี้จะได้แสดงการออกแบบในส่วนสเตเตอร์ 
Generator 

   

http://www.jojothai.com/
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(ก) มอเตอร์เครื่องซักผ้า    (ข) สเตเตอร์ของมอเตอร ์

รูปท่ี 2.2 มอเตอร์เครือ่งซกัผ้าที่น ามาท า Generator 
ที่มา : จังหวัด เจริญสุข, 2017 

 

จากรปูที่ 2.2 (ข) สามารถแบ่งแยกข้ันตอนไดห้ลายวิธีซึ่งข้ึนอยู่กับประสบการณ์ของ
ผู้ออกแบบแตล่ะคน ส าหรับผู้เขียนสามารถแบ่งแยกข้ันตอนการออกแบบเป็น 4 ข้ันตอนหลกัได้
ดังนี ้

1. ส่วนที่เป็นทรงตันทั้งหมดสามารถใช้ค าสั่ง Extruded Boss/Base ข้ึนรูปช้ินส่วน
ให้เสร็จตามล าดับ ซึ่งจะแยกออกเป็น 8 ข้ันตอนย่อยดังจะได้แสดงในหัวข้อต่อไป   

 

 
รูปท่ี 2.3 การข้ึนรูปทรงตันด้วย Extruded Boss/Base 

ที่มา : จังหวัด เจริญสุข, 2017 
 

2. ท าส่วนโค้งมนด้วย Fillet ข้ันตอนนี้เป็นการท าส่วนโค้งแบบค่ามุมโค้งเท่ากัน
ตลอด (Constant Size Fillet) และการท าส่วนโค้งแบบเปลี่ยนแปลงขนาดส่วนโค้ง (Variable 
Size Fillet)  

 
 

รูปท่ี 2.4 การท าส่วนโค้งมนด้วย Fillet 
ที่มา : จังหวัด เจริญสุข, 2017 



 42 การออกแบบชิ้นส่วน 3 มิติ (Part) 

3. เจาะรูด้วย Hold Wizard ข้ันตอนนี้เหมาะส าหรับรูเจาะที่ต้องการน าไปใช้กับ
อุปกรณ์จับยึด (Fastener) ต่อไปเมื่อน าช้ินส่วนไปประกอบเข้าด้วยกัน (Assembly)  

 
 

รูปท่ี 2.5 การเจาะรูด้วย Hold Wizard 
ที่มา : จังหวัด เจริญสุข, 2017 

 

4. คัดลอกรูปทรงที่คล้ายกันด้วย Circular Pattern ข้ันตอนนี้เป็นข้ันตอนสุดท้าย
เนื่องจากรูปทรงต่างๆที่ใช้เป็นต้นแบบได้ถูกสร้างเสร็จแล้ว ดังนั้นจึงสามารถคัดลองรูปทรง
ต้นแบบไดเ้ลยท าให้ประหยัดเวลามากในการออกแบบ  

 
รูปท่ี 2.6 การคัดลอกรูปทรงทีเ่หมอืนกันด้วย Circular Pattern 

ที่มา : จังหวัด เจริญสุข, 2017 
 

 
 
 

ส่วนนี้เป็นการแสดงวิธีการออกแบบตามข้ันตอนที่ได้แบ่งไว้แล้ว 4 ข้ันตอนโดยในแต่ละ
ข้ันตอนน้ันผู้เขียนได้ทรอดแทรกเทคนิคและค าสั่งใหม่เพิ่มเติมอย่างต่อเนื่อง ซึ่งประกอบด้วย การ 

Extruded แบบมุมเอียง (Draft Angle) การคัดลอก Sketch ด้วยค าสั่ง  การสร้างเส้นร่าง

ด้วยค าสั่ง  การสร้าง Sketch จากเส้นขอบพื้นผิวที่ได้สร้างไว้แล้วด้วยค าสั่ง  
การตัด Sketch ที่ไม่ต้องการด้วยค าสั่ง  การขยายภาพเฉพาะส่วนด้วยค าสั่ง 

    ขั้นตอนเขียน Part 3 มิติโดยวิธี Extruded Boss/Base 2.2 
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Zoom to Area  การท าส่วนโค้งมนแบบคงที่  Constant Size Fillet การท าส่วนโค้งมน

แบบแปรผัน  Variable Size Fillet การเจาะรูด้วยค าสั่ง   ในส่วนค าสั่งที่ผู้อ่านเคยผ่าน
มาแล้วในบทที่ 1 ได้แก่ การคัดลอกแบบทรงกลม จะถูกน ามาใช้งานในส่วนน้ี
อีกครั้ง โดยตัวเลขที่ใช้ในการก าหนดขนาดได้จากการออกแบบให้ช้ินส่วนสามารถท างานได้ตาม
วัตถุประสงค์ซึ่งต้องศึกษาในวิชาการออกแบบเครื่องจักรกล 
 

2.2.1 การขึ้นรูปทรงตันด้วย Extruded Boss/Base 
 

ข้ันตอนน้ีเป็นการเริ่มต้นตามข้ันตอนส่วนที่ 1 ซึ่งเมื่อฝึกปฏิบัติเสร็จแล้วจะได้ตาม
รูป 2.3 โดยผู้อ่านจะได้ศึกษาการใช้ค าสั่งเพิ่มเติมดังนี้ การ Extruded แบบมุมเอียง (Draft 

Angle) การคัดลอก Sketch ด้วยค าสั่ง  การสร้างเส้นร่างด้วยค าสั่ง  การ

สร้าง Sketch จากเส้นขอบพื้นผิวที่ได้สร้างไว้แล้วด้วยค าสั่ง  การตัด Sketch ที่ไม่ต้องการ

ด้วยค าสั่ง  และการขยายภาพเฉพาะส่วนด้วยค าสั่ง Zoom to Area   
ผู้ อ่ านสามารถศึกษาตัวอย่างนี้ แบบคลิปวีดิ โอภาพเคลื่อนไหวควบคู่กับ หนังสือได้ที่  
www.engineeringksu.com/สื่อการสอน/SolidWorks/บทที่2การออกแบบช้ินส่วน 3 มิติ 
(Part)/การออกแบบ 3 มิติโดยวิธี  Extruded Boss/Base 

 
การสร้างทรงตันบน Top plane 
 

1. เรียกค าสั่ ง   (Standard tool bar) จะปรากฏหน้าต่าง New 

SolidWorks document คลิกที่ Advance มุมซ้ายล้างหน้าต่างจะถูกเปลี่ยนเป็นหน้าต่างใหม่ให้

ท าดั้งนี ้(1) คลิกที่ Tutorial (2) คลิกที่ part (3) คลิกที่ OK 
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2. ก าหนดระบบหน่วยโดยคลิกที่ Options (Standard tool bar) 
(1)  คลิกที่  Document properties (2)  คลิกที่  Units (3) เลือกระบบหน่วยเป็น MMGS 
(millimeter, gram, second) 

 

 
 
 

 
จะเห็นได้ว่าในส่วนการฝึกปฏิบัติการออกแบบผ่านโปรแกรมผู้เขียนไม่ได้ใส่หมายเลขรูป

และค าอธิบายก ากับไว้ ดังนั้นขอให้ผู้อ่านเข้าใจได้ว่ารูปที่อยู่ส่วนล่างของค าอธิบายจะหมายถึงรูป
ที่ใช้ประกอบค าอธิบายแต่ละข้ันตอนน่ันเอง 

3. เลือกที่ Top plane  (Feature Manager Design Tree) 

4. เรียกค าสัง่ (Feature tool bar) Sketch จะถูกเปิดที่ Top plane 

5. เรียกค าสัง่  (Sketch Tool bar) คลิกทีจุ่ด Origin    ก าหนด
จุดศูนย์กลางของวงกลม เลื่อนเมาส์ไปทางด้านขวาเพื่อก าหนดรัศมีประมาณ 37 

 

 
 

ข้อสังเกต 
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6. เรียกค าสัง่ (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่องรับ
ค่าขนาดวงกลมใส่ค่า 300 

 

 
 

7. คลิก  (Sketch Tool bar) จะปรากฏ Property manager ของ 
Extrude Boss/Base ที่ด้านซ้ายแทนที่ Feature Manager Design Tree (1) ใส่ค่า 72 ในช่อง 

 Depth และคลิกที่   

 
 

การตัดทรงตันจากการก าหนดพ้ืนผิว 
 

1. เลือกที่ผิวด้านบนจะแสดงเฉดสีบริเวณที่เลือก 
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2. เรียกค าสั่ง  (Feature tool bar) Sketch จะถูกเปิดบริเวณผิวที่เลอืก 
3. เรียกค าสั่ง (Sketch Tool bar) ใช้จุด Origin เป็นจุดศูนย์กลาง

วงกลมและเขียนวงกลมโดยประมาณค่ารัศมี 130 

        
 

4. เรียกค าสั่ง  (Dimension tool bar) คลิกที่วงกลมและใส่ค่า 280 ใน
กล่องรับค่า 

 
 

5 .  คลิ ก   ( Sketch Tool bar)  จะปรากฏ Property Manager ของ 

Extrude Cut ที่ด้านซ้าย(1) ใส่ค่า 70 ในช่อง  Depth และคลิกที่  
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 การสร้างทรงตันส่วนกลาง 
 

1. เลือกที่ผิวด้านล่างจะแสดงเฉดส ี
 

 
 

2. เรียกค าสั่ง (Feature tool bar) Sketch จะถูกเปิดที่ผิวที่เลือกไว้ 

3. เรียกค าสั่ง  (Sketch Tool bar) คลิกที่จุด Origin   ก าหนดจุด
ศูนย์กลางของวงกลมเขียนวงกลมโดยการประมาณค่ารัศมี 116 

   
 

4. เรียกค าสั่ง  (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่อง
รับค่าขนาดวงกลมใส่ค่า 120 
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5.  คลิ ก   ( Sketch Tool bar)  จ ะป รากฏ  Property manager ขอ ง 
Extrude Boss/Base ที่ด้านซ้ายแทนที่ Feature Manager Design Tree (1) ใส่ค่า 27 ในช่อง 

  Depth (2) ใส่ค่า 10 ในช่อง   Draft Angle คลิกที่  
 

 
 

การสร้างทรงตันจากผิวทรงตันกลาง 
 

1. เลือกที่ผิวด้านบนจะแสดงเฉดสี 
 

 
 

2. เรียกค าสั่ง (Feature tool bar) Sketch จะถูกเปิดที่ผิวที่เลือกไว้ 

3. เรียกค าสั่ง  (Sketch Tool bar) คลิกที่จุด Origin ก าหนดจุด
ศูนย์กลางของวงกลมเขียนวงกลมโดยการประมาณค่ารัศมี 48 
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4. เรียกค าสั่ง (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่องรับค่า
ขนาดวงกลมใส่ค่า 50 

 
 

5. คลิก  (Sketch Tool bar) จะปรากฏ Property manager ของ Extrude 

Boss/Base ที่ด้านซ้าย (1) ใส่ค่า 5 ในช่อง  Depth คลิกที่   
 

 
 

การสร้างทรงตันส่วนบน 
 

1. เลือกที่ผิวด้านบนจะแสดงเฉดสี 
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2. เรียกค าสั่ง  (Feature tool bar) Sketch จะถูกเปิดที่ผิวที่เลือกไว้ 
 

3. เรียกค าสั่ ง  (Sketch Tool bar) คลิกที่จุด Origin  ก าหนดจุด
ศูนย์กลางของวงกลม เขียนวงกลมโดยการประมาณค่ารัศมี 30 

4. เรียกค าสั่ง (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่องรับค่า
ขนาดวงกลมใส่ค่า 30 

 
 

5. คลิก  (Sketch Tool bar) จะปรากฏ Property manager ของ Extrude 

Boss/Base ที่ด้านซ้าย(1) ใส่ค่า 10 ในช่อง  Depth (2) ใส่ค่า 10 ในช่อง Draft Angle 

คลิกที่  
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การสร้างทรงตันส าหรับคัดลอกแบบ Circular ส่วนท่ี 1 
 

1. เลือกที่ผิวด้านล่างจะแสดงเฉดสี 
 

 
 

2. เรียกค าสั่ง (Feature tool bar) Sketch จะถูกเปิดที่ผิวที่เลือกไว้ปรับ

ภาพเป็น Top view   (View Tool bar)  

3. เรียกค าสั่ง  (Sketch tool bar) คลิกที่จุด Origin   เพื่อก าหนด
จุดเริ่มต้นเขียนเส้นไปทางด้านขวาโดยให้ถึงขอบวงกลมด้านในของช้ินส่วน 

 

            
 

4. เรียกค าสั่ง  (Sketch tool bar) (1) คลิกเส้น Center line (2) ใส่ค่า 5 ใน

ช่อง  Offset Distant สามารถเปลี่ยนทิศทางการ offset โดยท าเครื่องหมายหน้า Reverse 
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5. ท าซ้ าข้ันตอน 4 โดยเปลี่ยนทิศทางการ Offset ด้วยการท าเครื่องหมายหน้า 

Revers  
 

  
 

6. เปลี่ยนขอบรูปเป็น Sketch โดยเลือกที่เส้นขอบดังรูปซ้าย เรียกค าสั่ง   
(Sketch tool bar) เส้นขอบที่เลือกจะถูกเปลี่ยนเป็น Sketch เส้นสีด าดังรูปขวา 

 

  
 

7. ท าซ้ าข้ันตอน 6 โดยเลือกวงกลมด้านใน 
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8. เรียกค าสั่ง  (Sketch tool bar) (1) คลิกที่  ภายใต้ 
Options (2) คลิกที่เส้นวงกลมนอก  

 

 
 

9. ท าซ้ าข้ันตอนที่ 8 โดย (1) คลิกที่เส้นวงกลมใน (2) คลิกที่เส้นส่วนเกินทั้งสอง 
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10. เรียกค าสั่ง  (View tool bar) (1) ก าหนดขอบเขต Zoom จะปรากฏเห็น
ปลายเส้นส่วนเกินให้ Trim ที่ปลายเส้นส่วนเกินทั้งสอง 

 

   
 

11. คลิกที่  (Sketch Tool bar) จะปรากฏ Property Manager ของ Extrude 

Boss/Base ที่ด้านซ้าย(1) ใส่ค่า 10 ในช่อง  Depth (2) ใส่ค่า 5 ในช่อง Draft Angle 
คลิกที่  
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การสร้างทรงตันส าหรับคัดลอกแบบ Circular ส่วนท่ี 2 
 

1. เลือกทีผิวจะแสดงเฉดสี 

 
 

2. เรียกค าสั่ง   (Feature tool bar) Sketch จะถูกเปิดปรับภาพเป็น Top 

view   (View Tool bar)  
 
 
 

3. เรียกค าสั่ง  (Sketch tool bar) คลิกที่จุด Origin  เพื่อก าหนด
จุดเริ่มต้นเขียนเส้นไปทางด้านขวาโดยให้ถึงขอบวงกลม 

 

 
 

4. เรียกค าสั่ง  (Sketch tool bar) (1) คลิกที่เส้น Center line (2) ใส่ค่า 1.5 

ในช่อง  Offset Distant สามารถเปลี่ยนทิศทางการ Offset โดยท าเครื่องหมายหน้า 

Reverse คลิกที่    
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5. ท าซ้ าข้ันตอน 4 โดยเปลี่ยนทิศทางการ Offset ด้วยการท าเครื่องหมายหน้า 

Revers  

  

6. เลือกที่เส้นขอบวงกลมเรียกค าสั่ง  (Sketch tool bar) เส้นขอบที่เลือกจะ
ถูกเปลี่ยนเป็น Sketch สีด า 

 

 
 

7. ท าซ้ าข้ันตอน 6 โดยเลือกวงกลมในเส้นขอบที่เลือกจะถูกเปลี่ยนเป็น Sketch  
สีด า 



 57 การออกแบบชิ้นส่วน 3 มิติ (Part) 

 
 

8. เรียกค าสั่ง  (Sketch tool bar) ภายใต้ Options เลือก ใน 
Property Manager (1) คลิกวงกลมนอก (2)คลิกเส้นวงกลมใน (3)คลิกปลายเส้นซ้าย (4)คลิก

ปลายเส้นขวา คลิกที่    
 

    
 

9. คลิก  (Sketch Tool bar) จะปรากฏ Property Manager ของ Extrude 

Boss/Base ที่ด้านซ้ายใส่ค่า 2 ในช่อง  Depth คลิกที่   

 
 
 

จะเห็นว่าขณะนี้รูปทรงจะได้ตามรูปที่ 2.3 ซึ่งเป็นการใช้ค าสัง่ Extruded Boss/Base ซึ่ง
คือการให้ความลึกจาก 2D Sketch 

 

ข้อสังเกต 
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2.2.2 การท าส่วนโค้งด้วย Fillet 

 

ข้ันตอนน้ีเป็นการแสดงตามขั้นตอนใหญ่ส่วนที่ 2 ซึ่งเมื่อฝึกปฏิบัติเสร็จแล้วจะได้

ตามรูป 2.4 โดยผู้อ่านจะได้ศึกษาการใช้ค าสั่งเพิ่มเติม คือ การท าส่วนโค้งมนแบบคงที่  

Constant Size Fillet และการท าส่วนโค้งมนแบบแปรผัน  Variable Size Fillet 
 
1. เรียกค าสั่ง  (Feature tool bar) ก าหนดค่าใน Property manager (1) 

คลิกที่  Constant Size Fillet ภายใต้ Fillet Type (2) ท าเครื่องหมายหน้า Full Preview 

(3) ก าหนดค่ารัศมี 1 ใน Radius  (4) เลือกที่มุมทั้งสอง คลิกที่   
 

 
2. ท าซ้ าข้ันตอนที่ 1 โดย (1) ก าหนดค่ารัศมี 0.5 ใน Radius   (2) คลิกที่เส้น

ทั้งสอง คลิกที่   
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3. ท าซ้ าข้ันตอนที่ 1 โดย (1) ก าหนดค่ารัศมี 5 ใน Radius   (2) คลิกที่ผิวทั้ง

สอง คลิกที่   
 

 
 

4. ท าซ้ าข้ันตอนที่ 1 โดย (1) ก าหนดค่ารัศมี 2 ใน Radius   (2) คลิกที่ขอบผิว 

คลิกที่   สองครั้ง 
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5. เรียกค าสั่ง  (Feature tool bar) ก าหนดค่าใน Property Manager (1) 

คลิกที่ Variable Size Fillet ภายใต้ Fillet Type (2) ท าเครื่องหมายหน้า Full Preview (3) 

คลิกผิวทั้งสอง (4) คลิกที่ V1 (5) ใส่ค่า R=1 ในช่อง  (6) คลิกที่   (7) คลิกที่ 

V2 ใส่ค่า R=4, V3 R=4, V4 R=1 ภายไต้ Variable Radius Parameters คลิกที่   สองครั้ง 
 

     
 
 

2.2.3 การเจาะรูด้วย Hole Wizard 
 

ข้ันตอนน้ีเป็นการแสดงตามขั้นตอนใหญส่่วนที่ 3 ซึ่งเมื่อฝึกปฏิบัติเสรจ็แล้วจะได้

ตามรูป 2.5 โดยผู้อ่านจะได้ศึกษาการใช้ค าสัง่เพิม่เติม คือ การเจาะรูด้วยค าสัง่    
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1. เรียกค าสั่ง  (View tool bar) เพื่อปรับมุมมองภาพเป็น Top View 

2. เรียกค าสั่ง  (Feature tool bar) ก าหนดค่าใน Property Manager (1) 

คลิกที่   ภายใต้ Hole Type (2) เลือกเป็น ANSI Metric ภายใต้ Standard (3) เลือกเป็น 
Dill Sizes ภายใต้ Type (4) เลือก 10.0 ภายใต้ Size (5) เลือก Through All ภายใต้ End 
condition (6) คลิกที่ Positions (7) คลิกที่ Origin เพื่อก าหนดจุดศูนย์กลางรูเจาะที่ 1 (8) คลิก
ด้านขวาก าหนดศูนย์กลางรูเจาะที่ 2 พร้อมก าหนดระยะห่าง 40 โดยใช้ Smart Dimension  

คลิกที่   สองครั้ง 

   
 

    2.2.4 การคัดลอกแบบทรงกลมด้วย Circular Pattern 
 

ข้ันตอนน้ีเป็นการแสดงตามขั้นตอนใหญส่่วนที่ 4 ซึ่งเมื่อฝึกปฏิบัติเสรจ็แล้วจะได้
ตามรูป 2.6 โดยผู้อ่านเคยใช้ค าสั่งคัดลอกผ่านมาแล้วในบทที่ 1   

1. เปิดแกนอ้างองิส าหรบัคัดลอกโดยไปที่ Menu bar>View>Hid/ Show> 
Temporary Axes จะปรากฏแกนสีน้ าเงินทีจุ่ดศูนย์กลางรเูจาะ 

2. เรียกค าสั่ ง  (Feature tool bar) ก าหนดค่าใน Property 

Manager (1)  คลิกที่ แกนสีน้ า เงินตรงกลาง ช้ินส่วนส าหรับ Pattern Axis   ภายใต้  

Parameters (2) ใส่ค่ามุม 360 ส าหรับ Angle  (3) ใส่ค่า 24 ส าหรับ Number Instant  
(4) ท าเครื่องหมายหน้า Equal spacing (5) เลือก Boss-Extrude5, Boss-Extrude6, Fillet1, 
Fillet2 และ VarFillet1 ใน Feature Manager Design Tree Fly out ส าหรับ Features and 

Faces คลิกที่   
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3. เรียกค าสั่ง  (Feature tool bar) ก าหนดค่าใน Property 

manager (1) คลิกที่แกนสีน้ าเงินตรงกลาง ช้ินส่วนส าหรับ Pattern Axis   ภายใต้  

Parameters (2) ใส่ค่ามุม 360 ส าหรับ Angle  (3) ใส่ค่า 3 ส าหรับ Number Instant   
(4) ท าเครื่องหมายหน้า Equal spacing (5) คลิกที่ Ø10.0 (10) Diameter Hole1 ใน Feature 
Manager Design Tree Fly out 
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4. เรียกค าสัง่บันทึกไฟล์ (Standard tool bar) โดยท าตามข้ันตอนดังได้
กล่าวมาแล้วในบทที่ 1 โดยตั้งช่ือไฟล์ในช่อง File name เปน็ Pic-26.SLDPRT  

 
 

 

ประเด็นส าคัญหัวข้อนี้ คือ การแยกรูปแบบที่คล้ายกันให้อยู่ในข้ันตอนต่อเนื่องกันและ
รูปทรงที่เหมือนกันให้ใช้การคัดลอกจากต้นแบบซึ่งจะช่วยลดข้ันตอนการเขียนแบบได้มาก เพื่อ
เป็นการทวนสอบความเข้าใจของผู้อ่านขอให้ท าแบบฝึกหัดข้อที่ 3 ซึ่งแบบฝึกหัดมีวัตถุประสงค์
เพื่อให้ผู้อ่านได้ฝึกท าตามข้ันตอนที่ได้แสดงผ่านมาแล้วอีกครั้งโดยมีการเพิ่มขนาดให้ใหญ่ข้ึนกว่า
ในตัวอย่าง จากนั้นให้ท าแบบฝึกหัดข้อที่ 4 ซึ่งมีการประยุกต์มากกว่าในตัวอย่าง เมื่อผู้อ่านผ่าน
แบบฝึกหัด 2 ข้อดังกล่าวด้วยตัวเองแล้ว ก็จะท าให้มีพื้นฐานที่สามารถท าความเข้าใจเนื้อหาส่วน
ต่อไปได้เร็วข้ึน 
 
 
 

ช้ินส่วนที่เหมาะสมกับวิธี Revolved Boss/Base จะคล้ายกับ Extruded Boss/Base 
คือมีลักษณะสมมาตรแต่เป็นการสมมาตรรอบแกน โดยสังเกตุจากรูปทรงจะสมมาตรตลอดมุม 
360 องศา ช้ินส่วนลักษณะนี้แม้จะสามารถใช้ Extruded Boss/Base ได้แต่ไม่เหมาะสมเนื่องจาก
จะมีข้ันตอนมากกว่าการใช้ Revolved Boss/Base ซึ่งหมายถึงจะใช้เวลาในการออกแบบเพิ่มมา
ข้ึนตามไปด้วย 
 

     2.3.1 หลักการเลือก Part ท่ีเหมาะสมกับวิธี Revolved Boss/Base 
 

หลักในการเลือก Part ที่ เหมาะส าหรับออกแบบ 3 มิติโดยใช้วิธี Revolved 
Boss/Base คือ Part ที่มีรูปทรงไม่สมมาตรตลอดความลึกในทิศทางที่ต้องการเพิ่มความลึกให้
เป็นช้ินส่วน 3 มิติ (รูปร่างเปลี่ยนแปลงมีลักษณะโค้งเว้าดังรูปที่ 2.5) ไม่เหมาะสมกับการ
ออกแบบช้ินส่วนรูปทรงลักษณะนี้ด้วย Extruded Boss/Base วิธีที่เหมาะสมคือการเขียนช้ินส่วน
เพียงครึ่งส่วนดังรูปที่ 2.8 (ก) แล้วใช้การ Revolve Boss/Base ดังรูปที่ 2.8 (ข) ซึ่งจะพบว่าใน
การข้ึนรูปช้ินส่วนลักษณะนี้จะมีความรวดเร็วมาก 

    หลักการเลือกและเขียน Part 3 มิติโดยวิธี Revolved Boss/Base 
2.3 

สรุป 
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รูปท่ี 2.7 ลักษณะรูปทรงที่ไมส่มมาตรในทิศทางแนวแกน Y 
ที่มา : จังหวัด เจริญสุข, 2560 

 
 

(ก) การเขียนช้ินส่วนครึ่งส่วน (ข)  การ Revolved Boss/Base 
 

รูปท่ี 2.8 การ Revolved Boss/Base จาก Sketch ครึ่งส่วน 
ที่มา : จังหวัด เจริญสุข, 2560 

 

2.3.2 การแบ่งขั้นตอนเขียน Part โดยวิธี Revolved Boss/Base 
Part ที่ใช้ประกอบแสดงวิธีการเขียนด้วยวิธี Revolved Boss/Base นี้เป็นล้อช่วย

แรง  

 
รูปท่ี 2.9 ล้อช่วยแรงเครื่องสูบน้ า 

ที่มา : เกษตรพอเพียง, 2559 
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โดยข้ันตอนน้ันจะแบง่ออกเป็น 6 ข้ันตอนใหญ่ดังนี ้
1. Sketch 2 มิติแล้วใช้ 2 มิตินั้น Revolved Boss/Base ได้รูปทรงหมุนรอบแกน 
 

 
รูปท่ี 2.10 การ Sketch 2 มิติเพื่อ Revolved Boss/Base 

ที่มา : จังหวัด เจริญสุข, 2560 

 
2. ข้ึนรูปแกนกลางแบบทรงตันโดยใช้วิธีแบบ Mid Plane 

 
รูปท่ี 2.11 การข้ึนรูปทรงตันโดยใช้วิธีแบบ Mid Plane 

ที่มา : จังหวัด เจริญสุข, 2560 
 

3. เจาะรูเพื่อเป็นต้นแบบส าหรับใช้คัดลอกแบบ Circular Pattern 
 

 
รูปท่ี 2.12 การเจาะรูด้วย Extruded Cut 

ที่มา : จังหวัด เจริญสุข, 2560 
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4. คัดลอกรูเจาะแบบ Circular Pattern และใช้ Equation ในการปรับเปลี่ยนการ
ออกแบบ 

 
รูปท่ี 2.13 การคัดลอกและสร้าง Equation 

ที่มา : จังหวัด เจริญสุข, 2560 
 
 

 
ส่วนน้ีเป็นการแสดงวิธีการออกแบบตามขั้นตอนที่ได้แบ่งไว้แล้ว 4 ข้ันตอน โดยผู้อ่านจะ

ได้เรียนรู้เทคนิคและค าสั่งใหม่เพิ่มเติม ดังนี้ การเขียนส่วนโค้งโดยใช้ค าสั่ง  การ

คัดลอก Sketch แบบพลิกกลับด้วยค าสั่ง  การแก้ใข Feature ที่ได้สร้างผ่าน

มาแล้วด้วยค าสั่ง Edit Feature   การปรับการแสดงภาพแบบ Hidden line Remove การ
ปรับการแสดงภาพโดยใช้ Coordinate การ Extruded Boss/Base ออกสองด้านแบบ Mid 

Plane การแสดงภาพตัดด้วย Section View  และการเปลี่ยนแปลงการออกแบบอย่าง

รวดเร็วด้วย   โดยตัวเลขที่ใช้ในการก าหนดขนาดได้จากการออกแบบให้ช้ินส่วน
สามารถท างานได้ตามวัตถุประสงค์ซึ่งต้องศึกษาในวิชาการออกแบบเครื่องจักรกล 
 

2.4.1 การ Sketch 2 มิติส าหรับวิธี Revolved Boss/Base 
 

ข้ันตอนนี้จะแสดงวิธีการ Sketch 2 มิติแล้วคัดลอก Sketch แบบพลิกกลับด้วยค าสั่ง 

 ซึ่งเมื่อฝึกปฏิบัติเสร็จแล้วจะได้ตามรูป 2.10 ค าสั่งใหม่ที่จะได้เรียนรู้เพิ่มเติม

ประกอบด้วย ค าสั่งข้ึนรูป 3 มิติแบบ   ค าสั่งเขียนส่วนโค้ง  และการแก้

ใช Feature ที่ได้สร้างผ่านมาแล้วด้วยค าสั่ง Edit Feature  ผู้อ่านสามารถศึกษาตัวอย่างนี้
แบบคลิปวีดิโอภาพเคลื่อนไหวควบคู่กับหนังสือได้ที่ www.engineeringksu.com/สื่อการสอน/
SolidWorks/บทที่2การออกแบบช้ินส่วน 3 มิติ (Part)/การออกแบบ 3 มิติโดยวิธี Revolved 
Boss/Base 

   ขั้นตอนเขียน Part 3 มิติโดยวิธี Revolved Boss/Base   
2.4 
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การสรา้งไฟล์ใหม ่
1. เรียกค าสั่ ง   (Standard tool bar) จะปรากฏหน้าต่าง New 

SolidWorks document คลิกที่ Advance มุมซ้ายล้างหน้าต่างจะถูกเปลี่ยนเป็นหน้าต่างใหม่ให้

ท าดั้งนี ้(1) คลิกที่ Tutorial (2) คลิกที่ part (3) คลิกที่ OK 

 

 
 

2. ก าหนดระบบหน่วยโดยคลิกที่ Options (Standard tool bar) (1) 
คลิกที่ Document Properties (2) คลิกที่ Units (3) เลือกระบบหน่วยเปน็ MMGS (millimeter, 
gram, second) 
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เริ่มสร้าง Sketch ส าหรับ Revolved Boss/Base 

 

1. เลือกที่  (Feature Manager Design Tree) 

2. เรียกค าสัง่  (Feature tool bar) Sketch จะถูกเปิดที่ Front plane 

3. เรียกค าสั่ง  (Sketch Tool bar) คลิกที่จุด Origin  ก าหนด
จุดเริ่มต้นเขียนเส้นในแนวตั้งโดยความยาวประมาณ 90 กดปุ่ม ESC บนแป้นคีย์บร์อดเพื่อจบ
ค าสั่ง 

 
 

4. เรียกค าสั่ง  (Sketch Tool bar) ใช้ปลายเส้น Centerline และจุด 

Origin  เป็นจุดเริ่มต้น Sketch ให้ได้ดังรูปกด ESC บนคีย์บอร์ด 
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5. เรียกค าสั่ ง  (Sketch Tool bar) ใช้ปลายเส้นด้านล่างเป็น
จุดเริ่มต้นเขียนส่วนโค้งไปยังปลายเส้นด้านบน คลิก       

 

 

6. เรียกค าสั่ง (Dimension tool bar) ก าหนดขนาดดังรูป 
 

 
 

การคัดลอก Sketch แบบพลิกกลับ 
 

1. เรียกค าสั่ง   (Sketch Tool bar) เลือก Sketch ทั้ง 4 ส าหรับ 
Entities to mirror และเส้น Centerline ส าหรับ Mirror about 
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2.4.2 การขึ้นรูป 3 มิติโดยวิธี Revolved Boss/Base 
 

1. คลิก  (Sketch Tool bar) ภายใต ้Property Manager เลือกแกนกลางทีจ่ดุ 

Origin  เพื่อเป็นแกนส าหรับหมุนรอบ Axis of Revolution และคลิกที่   
 

 
สังเกตุว่ารูปทรงจะได้ตามรูปที่ 2.10 ซึ่งหากใช้วิธี Extruded Boss/Base ที่บริเวณส่วนโค้งจะท า
ได้ยากกว่าการใช้ Revolved Boss/Base 

 
 
 

หากต้องการแก้ไข Feature ที่ได้ท าผ่านมาแล้วสามารถท าได้ดังนี้ 
คลิกเมาส์ทางด้านขวามือที่ Feature ที่ต้องการแก้ไขจะปรากฏเมนูบาร์ให้เลือกที่  Edit 

Feature  จะปรากฏ Property Manager ของ Revolve ปรากฏที่ด้านซ้าย สามารถ

เปลี่ยนแปลงแก้ไขได้ เมื่อแก้ไขเสร็จแล้ว คลิกที่    
 

 

ค าแนะน า 
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2.4.3 การขึ้นรูปทรงตันแบบ Mid Plane ด้วย Extruded Boss/Base  
 

ข้ันตอนนี้เป็นการแสดงตามข้ันตอนส่วนที่ 2 ซึ่งเมื่อฝึกปฏิบัติเสร็จแล้วจะได้ตาม
รูป 2.11 โดยผู้อ่านจะได้ศึกษาการใช้ค าสั่งเพิ่มเติม ดังนี้ การปรับการแสดงภาพโดยใช้ 

Coordinate การปรับการแสดงภาพแบบ Hidden line Remove การ Extruded 
Boss/Base ออกสองด้านด้วย Mid Plane 

1. เลือกที่  (Feature Manager Design Tree) 

2. เรียกค าสั่ง  (Feature tool bar) Sketch จะถูกเปิดที่ Right plane 
3. ปรับ View port เป็น Right View โดยการคลิกที่แกน X บน Coordinate  

 

4. เรียกค าสั่ง  (Sketch Tool bar) คลิกที่จุด Origin ก าหนดจุด
ศูนย์กลางของวงกลม เขียนวงกลมโดยการประมาณค่ารัศมี 80 

 

 
 

5. เรียกค าสั่ง  (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่องรับค่า

ขนาดวงกลมใส่ค่า 80 คลิกที่   
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6. ปรับ View port เป็น Top View โดยการกดอักษร T (เมื่อมีการก าหนดแป้นคีย์
บอร์ดแล้ว) ปรับการแสดงสีเป็น Hidden line Remove  

 

 
 

7. คลิก   (Sketch Tool bar) ภายใต้ Property manager ให้ก าหนดดังนี้ (1) 

ใต้ Direction1 เลือกเป็น Mid plane (2) ใส่ค่า 60 ในช่อง   Depth และคลิกที่  กดที่
อักษร I เพื่อปรับภาพเป็น Isometric ปรับการแสดงสีเป็น Shaded with edges 

 

   
 

2.4.4 การตัดทรงตันแบบ Mid Plane ด้วย Extruded Cut 
 

ตัดส่วนด้านนอก 
1. ปรับการแสดงสเีป็น Hidden line Remove (View tool bar)  
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2. เลือกที่  (Feature Manager Design Tree) 

3. เรียกค าสัง่  (Feature tool bar) Sketch จะถูกเปิดที่ Right plane 
4. ปรับ View port เป็น Right View โดยการคลิกที่แกน X บน Coordinate  
 

 

5. เรียกค าสั่ง  (Sketch Tool bar) ช้ีเมาส์ที่จุด Origin เลื่อนเมาส์ข้ึน
ด้านบนก าหนดจุดศูนย์กลางของวงกลม เขียนวงกลมโดยการประมาณค่ารัศมี 20 

 

 
 

6. เรียกค าสั่ง  (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่องรับค่า
ขนาดวงกลมใส่ค่า 40 และระยะห่างจาก Origin เท่ากับ 75 คลิกบนพื้นที่ว่างใน Model ปรับ 
View port เป็น Top View โดยการกดอักษร T 
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7. คลิก   (Sketch Tool bar) ภายใต ้Property manager ให้ก าหนดดังนี้ (1) 

ใต้ Direction1 เลือกเป็น Mid plane (2) ใส่ค่า 100 ในช่อง   Depth และคลิกที่  กดที่
อักษร I เพื่อปรับภาพเป็น Isometric ปรับการแสดงสีเป็น Shaded with edges    

 

  
 

8. เรียกค าสั่ง Section View  (View tool bar) ภายใต้ Property Manager 
ให้ก าหนดดังนี้ (1) ใต้ Section Method ท าเครื่องหมายหน้า Planar (2) ใต้ Section Options 
ท าเครื่องหมายหน้า Reference plane และ Show section cap (3) ใต้ Section 1 คลิกที่  

Front  คลิกที่  
 

 
 

9. คลิกที่ Section View  เพื่อออกจากค าสั่ง 
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เจาะรแูกนกลาง 

 

1. เลือกที่  (Feature Manager Design Tree) 

2. เรียกค าสั่ง  (Feature tool bar) Sketch จะถูกเปิดที่ Right plane 
 
3. ปรับ View port เป็น Right View โดยการคลิกที่แกน X บน Coordinate  
 

 

4. เรียกค าสั่ง  (Sketch Tool bar) คลิกที่จุด Origin    ก าหนดจุด
ศูนย์กลางของวงกลม เขียนวงกลมโดยการประมาณค่ารัศมี 20 

 

 

5. เรียกค าสั่ง  (Dimension tool bar) คลิกที่วงกลมจะปรากฏกล่องรับค่า
ขนาดวงกลมใส่ค่า 50 คลิกบนพื้นที่ว่างใดๆใน Model ปรับ View port เป็น Top View โดยการ
กดอักษร T 
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6. คลิก  (Sketch Tool bar) ภายใต ้Property manager ก าหนดดังนี้ (1) ใต้ 

Direction1 เลือกเป็น Mid plane (2) ใส่ค่า 100 ในช่อง Depth  และคลิกที่  คลิกพื้นที่
ว่างใดๆ กดที่อักษร I เพื่อปรับภาพเป็น Isometric ปรับการแสดงสีเป็น Shaded with edges  

 

  
 

7. เรียกค าสั่ง Section View  (View tool bar) ภายใต้ Property Manager 
ก าหนดดังนี้ (1) ใต้ Section Method ท าเครื่องหมายหน้า Planar (2) ใต้ Section Options 
ท าเครื่องหมายหน้า Reference Plane และ Show section cap (3) ใต้ Section 1 คลิกที่  

Front   

  คลิกที่  
 

  
 

8. คลิกที่ Section View  เพื่อออกจากค าสั่ง 
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2.4.5 การใช้สมการ Equation ช่วยในการเปลี่ยนแปลงการออกแบบ 
 

ข้ันตอนน้ีเป็นการแสดงตามข้ันตอนส่วนที่ 4 ซึ่งเมื่อฝึกปฏิบัติเสร็จแล้วจะได้ตาม
รูป 2.13 ข้ันตอนนี้เป็นเทคนิควิธีที่เหมาะสมกับการน าไปประยุกต์ใช้ในการออกแบบเป็นอย่าง
มากเนื่องจากผู้ออกแบบจะสามารถเปลี่ยนแปลงการออกแบบได้อย่างรวดเร็วโดยการสร้าง

ความสัมพันธ์ของสัดส่วนต่างๆด้วยค าสั่ง  ซึ่ ง เป็นค าสั่ งที่ ช่วยให้สามารถ
เปลี่ยนแปลงการออกแบบได้อย่างรวดเร็วโดยไม่ต้องย้อนกลับไปแก้ไข Sketch ส่วนค าสั่งการ

คัดลอกแบบทรงกลม  นั้นผู้อ่านเคยได้ศึกษาและฝึกปฏิบัติผ่านมาแล้ว  
 
การคัดลอกรูปทรงท่ีเหมือนกันแบบทรงกลม 
 

1. เปิดแกนอ้างองิส าหรบัคัดลอกโดยไปที่ Menu bar>View>Hide/Show> 
Temporary Axes จะปรากฏแกนสีน้ าเงินทีจุ่ดศูนย์กลางรเูจาะ 
 

 
 

2.  คลิกที่ ศร   เรียกค าสั่ ง   (Feature tool bar) 
ภายใต้ Property Manager ก าหนดค่าดังนี้ (1) เลือกแกนสีน้ าเงินตรงกลางช้ินส่วนส าหรับ 

Pattern Axis   (2) ใส่ค่ามุม 120 ส าหรับ Angle  (3) ใส่ค่า 3 ส าหรับ Number  
Instant   (4) ปลดเครื่องหมายหน้า Equal spacing (5) ใต้ Feature and Faces เลือก Cut-

Extrude1 คลิกที่   
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การใช้สมการ Equation ช่วยในการคัดลอกแบบทรงกลม 

1. ปิดแกนอ้างอิงส าหรับคัดลอกโดยไปที่ Menu bar>View>Hide/Show> 
Temporary Axes แกนสีน้ าเงินที่จุดศูนย์กลางรูเจาะจะหายไป 

2. คลิกที่ CirPattern1 ใน Feature Manager Design Tree จะปรากฏมุม 120 
และ Number Instant คือ 3 จัดต าแหน่งดังรูป 

 

 
 

3. เรียกค าสั่ง  (Menu bar>Tool) จะปรากฏกล่อง Equation คลิก

ที่  CirPattern1 ใน Feature Manager Design Tree จะปรากฏมุม 120 และ Number 

Instant คือ 3 ก าหนดค่าดังนี้ (1) คลิกใต้ Equations คลิกที่ 120 เคอร์เซอร์จะไปอยู่ที่คอลัมน์ 
Value/Equation (2) ใส่ค่า 360 ตามด้วยเครื่องหมายหาร (3) คลิกที่เลข 3  (4) คลิกที่ OK 
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ทดสอบการท างานของ Equation 

1.  ที่  Feature Manager Design Tree ( 1 )  คลิ ก  CirPattern1 จ ะปรากฏมุ ม 

120 (2) คลิกที่  Number Instant คือ 3 เปลี่ยนค่าเป็น 4 กดปุ่ม Enter ค่ามุมจะถูก

ปรับเปลี่ยนเป็น 90 อัตโนมัติตามสมการที่ได้สร้างไว้ 
 

 
 

2. เรียกค าสัง่บันทึกไฟล์ (Standard tool bar) โดยท าตามข้ันตอนดังได้
กล่าวมาแล้วในบทที่ 1 โดยตั้งช่ือไฟล์ในช่อง File name เปน็ Pic-213.SLDPRT  
 
 

สาระที่ส าคัญ คือ การพิจารณาเลือกแกนอ้างอิงซึ่งจะท าให้ลดข้ันตอนและเวลาการข้ึน
รูปช้ินส่วน และให้ผู้อ่านเปรียบเทียบความแตกต่างระหว่างการเขียนช้ินส่วนด้วยค าสั่ง Extruded 
Boss/Base กับ Revolved Boss/Base แบบฝึกหัดท้ายบทข้อที่ 11 เป็นการให้ทบทวนข้ันตอน
ทุกข้ันตอน แบบฝึกหัดข้อที่ 12 เป็นแบบฝึกหัดที่ให้ผูอ้่านได้ฝึกออกแบบด้วยจินตนาการในตัวเอง 

 
 
 
 
 

สรุป 
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การออกแบบ 3 มิติที่ผ่านมาทั้งสองวิธีจะเห็นได้ว่าช้ินส่วน (Part) จะมีลักษณะสมมาตร
ตลอดความลึกด้านใดด้านหนึ่งส าหรับวิธี Extruded Boss/Base หรือถ้าสมมาตรรอบแกนหมุน 
360 องศา จะเหมาะสมกับวิธี Revolved Boss/Base แต่ส าหรับวิธี Swept Boss/Base ลักษณะ
ช้ินส่วนจะมีลักษณะสมมาตรตลอดรูปทรงแต่รูปทรงช้ินส่วนนั้นสามารถช้ีไปในทิศทางใดๆก็ได้
ข้ึนอยู่กับความต้องการของผู้ออกแบบดังจะได้แสดงให้เห็นในล าดับต่อไป 
 

2.5.1 หลักการเลือก Part ท่ีเหมาะสมกับวิธี Swept Boss/Base 
 

หลักการเลือก Part ที่เหมาะส าหรับออกแบบ 3 มิติโดยวิธี Swept Boss/Base คือ 
Part ที่มีลักษณะการข้ึนรูปเป็นเส้นทางที่มีการเปลี่ยนแปลงไปในทิศทางต่างๆดังรูป 2.14 คือ
ระบบท่อดูดลมในอุตสาหกรรมที่มีลักษณะการเดินท่อร่วมกันหลายท่อเพื่อให้สามารถที่จะเพิ่ม
ปริมาณหัวดูดลมได้มาก รูปทรงลักษณะนี้จะเหมาะสมกับการใช้วิธี ข้ึนรูปแบบ Swept 
Boss/Base 

 

 
รูปท่ี 2.14 ระบบท่อดูดลมในอุตสาหกรรม 

ที่มา : บริษัทเนเดอร์แมน, 2559 
 

   หลักการเลือก Part และออกแบบ 3 มิติโดยวิธี Swept Boss/Base 
2.5 
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2.5.2 หลักการออกแบบ Part โดยวิธี Swept Boss/Base 
 

 
(ก) ปากดูดที่ปลายท่อดูด   (ข) 3D โดยใช้วิธี Swept Boss/Base 

รูปท่ี 2.15 ปลายท่อที่น ามาออกแบบโดยวิธี Swept Boss/Base 
ที่มา : บริษัทเนเดอร์แมน, 2559 

 

ข้ันตอนในการออกแบบปลายทอ่ในรปูที่ 2.15 (ข) ประกอบไปด้วย 5 ข้ันตอนหลักดังนี ้
1. เรียกค าสั่ง  ในการสร้าง Sketch 3 มิติ ซึ่งจะประกอบไปด้วยสองสว่น 

คือ Sketch ส าหรับเป็นเส้นทางในการข้ึนรูป 3D (Path) และ Sketch ส าหรับรูปทรงของท่อ 
(Profile)  

 
 

รูปท่ี 2.16 การ Sketch 3D ส าหรับ Profile และ Path 
ที่มา : จังหวัด เจริญสุข, 2560 

 

2. เรียกค าสัง่  ส าหรับข้ึนรปูท่อตามเส้นทางของ Path     
ที่ได้ Skectch ไว้แล้ว 

 
 

รูปท่ี 2.17 การข้ึนรูปโดยใช้ Swept Boss/Base 
ที่มา : จังหวัด เจริญสุข, 2560 
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3. สร้าง Sketch ส่วนที่เป็นปากดูดท่อโดยการสร้าง Plane ข้ึนใหม่โดยอ้างอิงจาก 
Plane เดิมที่โปรแกรมสร้างมาให้ 

 
รูปท่ี 2.18 การ Sketch ส าหรับใช้กบั Loft 

ที่มา : จังหวัด เจริญสุข, 2560 
 

4. เรียกค าสั่ง   ในการข้ึนรูปปากดูดให้เช่ือมเข้ากับท่อ 
 

 
รูปท่ี 2.19 ลักษณะการใช้ค าสั่ง Loft 

ที่มา : จังหวัด เจริญสุข, 2560 
 

5. เรียกค าสั่ง   ในการคว้านให้เป็นท่อบาง 
 

 
รูปท่ี 2.20 ลักษณะการใช้ค าสั่ง Shell 

ที่มา : จังหวัด เจริญสุข, 2560 
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จากรูปที่ 2.15 ผู้เขียนได้แบ่งข้ันตอนการออกแบบไว้ 5 ข้ันตอน ค าสั่งและเทคนิคต่างๆที่
จะได้เรียนรู้เพิ่มเติมประกอบด้วย การสร้าง Sketch แบบ  การสร้างความสัมพันธ์ 
(Add Relation) การท าส่วนโค้งให้กับ Sketch ด้วยค าสั่ง  การข้ึนรูปช้ินส่วน

ด้วย การสร้างระนาบ(Plane) การข้ึนรูปช้ินส่วนด้วย  

และการคว้านด้วยค าสั่ง   
 

2.6.1 การ Sketch 2 มิติส าหรับวิธี Swept Boss/Base 
 

ข้ันตอนน้ีจะแสดงวิธีการ Sketch 3 มิติซึ่งจะเรียกว่า Path file ด้วยค าสั่ง 
แล้วให้ความสัมพันธ์กับ Sketch ท าส่วนโค้งด้วย และสร้าง Pro file ซึ่งจะได้
ตามรูปที่ 2.16 ผู้อ่านสามารถศึกษาตัวอย่างนี้แบบคลิปวีดิโอภาพเคลื่อนไหวควบคู่กับหนังสือไดท้ี่ 
www.engineeringksu.com/สื่อการสอน/SolidWorks/บทที่2การออกแบบช้ินส่วน 3 มิติ 
(Part)/การออกแบบ 3 มิติโดยวิธี Swept Boss/Base 

 

สร้างไฟล์ใหมแ่ละ สรา้ง Sketch แบบ 3D ส าหรับ Path 
 

1. สร้างไฟล์ Part ข้ึนใหม่และก าหนดระบบหน่วยเป็น Millimeter ดังแสดงใน
หัวข้อ 2.2  

2. เลือกที่  (Feature Manager Design Tree) 
3. เรียกค าสั่ง  (Sketch tool bar) Sketch จะถูกเปิดที่ Top plane 
4. เรียกค าสั่ง  (Sketch tool bar) คลิกที่จุด Origin เขียนเส้นข้ึนในทิศทาง

ของแกน Y โดยประมาณ 100 (สามารถเปลี่ยนทิศทางของ Coordinate โดยกดปุ่ม Tab 
 

 

   วิธีการออกแบบ 3 มิติโดยวิธี Swept Boss/Base 
2.6 
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5. เปลี่ยนทิศทางการเขียนเส้นโดยกดปุ่ม Tab เขียนเส้นในทิศทางของแกน X 
โดยประมาณ 100 และเขียนเส้นในทิศทางของแกน Y โดยประมาณ 100 กดปุ่ม Esc เพื่อจบ
ค าสั่ง 

 

   
 
6. กดปุ่ม Ctrl บนคีย์บอร์ดค้างไว้และเลือกเส้นทั้ง 3 จะปรากฏ Properties 

Manager ให้เลือก  ภายไต้ Add Relation คลิก  

7. เรียกค าสั่ง  (Dimension tool bar) ก าหนดขนาดเส้นแนวตั้งด้านล่าง 
100 คลิกที่    

 

 
 

8. เรียกค าสั่ง  (Sketch Tool bar) (1) ก าหนดค่า 25 ใน Fillet 
Radius ภายใต้ Fillet Parameters (2) เลือกที่มุมทั้งสองส าหรับ Entities to Fillet หากปรากฏ

กล่องค าถามให้ตอบ Yes คลิก  2 ครั้ง คลิกที่ Exit sketch  
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ที่ Feature Manager Design Tree จะปรากฏ Sketch1 
 

 
สร้าง Sketch 3D ส าหรับ Profile 
 

1. เลือกที่  (Feature Manager Design Tree) 

2. เรียกค าสั่ง   (Sketch tool bar) Sketch จะถูกเปิดบน Top plane 
 

 

3. เรียกค าสั่ง  (Sketch Tool bar) คลิกที่จุด Origin  เขียนวงกลม 

เรียกค าสั่ง   (Dimension tool bar) ก าหนดขนาดวงกลม 15  คลิก  และ     
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2.6.2 การขึ้นรูป 3 มิติโดยวิธี Swept Boss/Base 
 

1. เรียกค าสั่ ง    (Feature Tool bar) (1) เลือกที่วงกลม
ส าหรับ Profile (2) เลือกที่ 3D Sketch ส าหรับ Path คลิกที่    

 

  
 

 

2.6.3 การสร้าง Plane 
 

ข้ันตอนนี้เป็นการแสดงตามส่วนที่ 3 ซึ่งเมื่อฝึกปฏิบัติเสร็จแล้วจะได้ตามรูป 2.18 โดย
ผู้อ่านจะได้ศึกษาการใช้ค าสั่งเพิ่มเติม ดังนี้ การสร้างระนาบด้วยค าสั่ง ซึ่งปกติค่า
เริ่มต้นที่โปรแกรมก าหนดมาให้ตอนสร้างไฟล์ Part ข้ึนใหม่จะประกอบด้วยระนาบ 3 
ระนาบ คือ Front, Top, Right 

1. เลือกที่  (Feature Manager Design Tree) 
2. เรียกค าสั่ง    (Feature tool bar) Plane ใหม่จะถูกสร้างข้ึนโดย

อ้างอิงจาก Top plane (1) ก าหนดค่า 20 ใน Offset Distant  (2) ท าเครื่องหมายหน้า Flip 
offset เพื่อเปลี่ยนทิศทางการ Offset ปรับการแสดงภาพเป็น Front view เพื่อตรวจสอบ  
คลิก  
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ส า ม า ร ถ เ รี ย ก ค า สั่ ง ใ น ก า ร ส ร้ า ง  Plane ที่ เ ม นู บ า ร์  Insert>Reference 
Geometry>Plane 

 
2.6.4 การขึ้นรูป 3 มิตโิดย Loft 
หัวข้อนี้ผู้อ่านจะได้ศึกษาการใช้ค าสั่ง Loft ซึ่งได้เคยศึกษาผ่านมาแล้วในบทที่ 1 และ

ค าสั่งสร้าง 4 เหลี่ยมด้วย  
 

สร้าง Sketch ส าหรับ Loft 

1. เลือกที่ Face ด้านล่างท่อ เรียกค าสั่ง  (Sketch tool bar) Sketch จะถูก

เปิดที่ผิวด้านล่างท่อ เรียกค าสั่ง  (Sketch tool bar) วงกลมด้านนอกท่อจะถูกเปลี่ยนเป็น 

Sketch คลิกที่  
 

 
 

2. เลือกที่  (Feature Manager Design Tree) ที่ได้สร้างไว้แล้ว 

3. เรียกค าสั่ง   (Sketch tool bar) Sketch จะถูกเปิดบน Plane1 
 
 

ข้อสังเกต 
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4. เรียกค าสั่ง (Sketch Tool bar) เขียนสี่เหลี่ยมโดยใช้จุด 

Origin  เป็นจุดศูนย์กลางของสี่เหลี่ยม เรียกค าสั่ง  (Dimension tool bar) ก าหนด

ขนาดดังรูป และคลิกที่  จะเห็นว่ามี Sketch ถูกสร้างข้ึนที่ Feature Manager Design 
Tree สอง Sketch 

 

 
 
 

ขึ้นรูป 3D โดย Loft 

เรียกค าสั่ง (Feature Tool bar) (1) คลิกที่วงกลม Profile1 

(2) มุมของสี่เหลี่ยม Profile2  คลิก   
 

 
 
 
 
 
 



 89 การออกแบบชิ้นส่วน 3 มิติ (Part) 

2.6.5 การคว้านโดยใช้ Shell 

หัวข้อนี้เป็นการแสดงวิธีการคว้านให้ช้ินส่วนมีลักษณะเป็นแผ่นบางด้วยค าสั่ง  

1.  เ รี ย กค า สั่ ง   ( Feature Tool bar)  ภาย ใต้  Property Manager 

ก าหนดค่าดังนี้ (1) ใส่ค่า 1 ส าหรับ Thickness  ภายใต ้Parameters (2) ท าเครื่องหมายหนา้ 
Show preview (3)เลือกที่ผิวด้านบนของท่อ Face1 (4) ผิวด้านล่างของปากดูดท่อ Face2 

ส าหรับ Face to Remove คลิกที่  
 

 
 

2. เรียกค าสั่ง Section View  (View Tool bar) ภายใต้ Property Manager 
(1) เลือก Planar ภายใต้ Section Method (2) เลือก Reference Plane ภายใต้ Section 
Option (3) ท าเครื่องหมายหน้า Show section cap (4) เลือก Front ส าหรับ Reference 

Section Plane/Face คลิก   
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3. คลิกที่ Section View  (View Tool bar) อีกครั้งเพื่อออกจากค าสั่ง 
4. เรียกค าสัง่บันทึกไฟล์ (Standard tool bar) โดยท าตามข้ันตอนดังได้

กล่าวมาแล้วในบทที่ 1 โดยตั้งช่ือไฟล์ในช่อง File name เปน็ Pic-215.SLDPRT  
 

2.6.6 การสร้างสายพานโดย Swept Boss/Base 
การสร้างช้ินส่วนที่เป็นสายพานขับระบบจ าเป็นจะต้องศึกษาหัวข้อการประกอบ

ช้ินส่วน (Assembly) ก่อนเนื่องจาก สายพานที่สร้างนั้นจะต้องมคีวามยาวตามระยะตัวขับและตวั
ตาม ดังนั้น ในหัวข้อนี้จึงได้ยกไปอธิบายในบทที่ 3 หัวข้อ 3.3.9 ซึ่งจะท าให้สามารถท าความ
เข้าใจไดส้มบูรณ์มากกว่าที่จะแสดงไว้ในบทที่ 2 นี ้

 
 
 
การออกแบบส าหรับงาน Sheet Metal เป็นประโยชน์มากส าหรับงานตัดและพับ

เนื่องจากผู้ออกแบบสามารถออกแบบตามจินตนาการโดยเป็นไปตามเงื่อนไขข้อก าหนดของการ
ใช้งาน จากนั้นผู้ออกแบบสามารถที่จะหาขนาดแผ่นโลหะกว้างคูณยาวได้โดยใช้ค าสั่ง Flat 
pattern และยังสามารถ Export ไฟล์เพื่อน าเข้าไปท างานร่วมกับโปรแกรมอื่นๆได้ ซึ่งท าให้
ผู้ออกแบบลดข้ันตอนการค านวณหาขนาดแผ่นโลหะลงได้มาก 
 

2.7.1 หลักการเลือก Part ท่ีเหมาะสมกับงาน Sheet Metal 
Part ที่เหมาะสมกับการใช้วิธีการข้ึนรูปแบบงาน Sheet Metal คืองานที่มีลักษณะ

การข้ึนรูปโดยการเตรียมโลหะหรือสังกะสีแผ่นให้พอดีกับขนาดที่จะข้ึนรูปและจากนั้นพับข้ึนรูป
ตามแบบ ดังเช่น รูปที่ 2.21 เป็นงานพับข้ึนรูปปากดูดที่มลีักษณะปากเหลีย่มลดเป็นทรงกลม การ
เตรียมโลหะหรือสังกะสีแผ่นที่มีขนาดพอดีกับการพับข้ึนรูปได้แสดงในรูปที่ 2.22 

 

 
รูปท่ี 2.21 การพับท่อปากเหลี่ยมลดขนาดเป็นท่อกลม 

ที่มา : บริษัทไทยเมทัลเวิล, 2560 
 

   หลักการเลือก Part และออกแบบ 3 มิติส าหรับงาน Sheet Metal 
2.7 
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รูปท่ี 2.22 การออกแบบการเตรียมแผ่นโลหะส าหรับงานพบัข้ึนรูป 

ที่มา : จังหวัด เจริญสุข, 2560 
 

2.7.2 หลักการออกแบบ Part ส าหรับงาน Sheet Metal 
1. การสร้าง Plane ข้ึนใหม่เพิ่มเติมนอกจากที่โปรแกรมสร้างมาให้แบบอัตโนมัติ

พร้อมกับการสร้างไฟล์งานใหม่ โดย Plane ใหม่ที่สร้างข้ึนเป็นการอ้างอิงจาก Front Plane ที่
โปรแกรมสร้างให้โดยก าหนดระยะห่างจาก Plane อ้างอิงตามต้องการ 

 

 
รูปท่ี 2.23 การสร้าง Plane โดยอ้างอิงจาก Plane ที่โปรแกรมสร้างให ้

ที่มา : จังหวัด เจริญสุข, 2560 

 
2. Sketch ตามรูปทรงปากเหลี่ยมแล้วลดขนาดเป็นท่อกลม  
 

 
รูปท่ี 2.24 การเตรียม Sketch ส าหรับข้ึนรปูงาน Sheet Metal  

ที่มา : จังหวัด เจริญสุข, 2560 
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3. ข้ึนรูป Sheet Metal ของปากเหลี่ยมแล้วลดขนาดเป็นท่อกลมด้วย Lofted-
Bend โดยอ้างอิงจาก Sketch รูปที่ 2.24 

 

 
รูปท่ี 2.25 การข้ึนรูปท่อปากเหลี่ยมลดขนาดเป็นท่อกลม 

ที่มา : จังหวัด เจริญสุข, 2560 
 

4. คลี่แผ่นโลหะด้วยค าสั่ง Flat pattern ตามรูปที่ 2.25 ออกส าหรับจัดเตรียมแผ่น
โลหะเพื่อใช้ในการพับข้ึนรูป 

 
รูปท่ี 2.26 การคลี่รูปทรง 3D เป็น Sheet Metal  2D 

ที่มา : จังหวัด เจริญสุข, 2560 
 

 
 

จากรูปที่ 2.22 ผู้เขียนได้แบ่งข้ันตอนการออกแบบไว้ 4 ข้ันตอน ค าสั่งในการสร้างระนาบ
นั้นผู้อ่านได้เคยศึกษาผ่านมาแล้วแต่เทคนิคใหม่ที่จะได้เรียนรู้เพิ่มเติมประกอบด้วย การสร้าง 

Sketch บนระนาบที่ได้สร้างไว้แล้วการสร้างงาน Sheet Metal ด้วย Lofted-Bend  การ
คัดลอก Sketch ที่ได้สร้างไว้แล้วไปยังระนาบใหม่ การคลี่งาน Sheet Metal ด้วย Flatten   
และการ Export ไฟล์เพื่อน าออกไปท างานร่วมกับโปรแกรมอื่น 

 
2.8.1 การสร้าง Plane  
ข้ันตอนนี้เป็นการสร้าง Plane ข้ึนใหม่เพื่อใช้ในการสร้าง Sketch ซึ่งจะได้ตามรูปที่ 

2.23 ผู้อ่านสามารถศึกษาตัวอย่างนี้แบบคลิปวีดิโอภาพเคลื่อนไหวควบคู่กับหนังสือได้ที่ 
www.engineeringksu.com/สื่อการสอน/SolidWorks/บทที่2การออกแบบช้ินส่วน 3 มิติ 
(Part)/การออกแบบ 3 มิติโดยวิธี Sheet Metal 

   วิธีการออกแบบ 3 มิติส าหรับงาน Sheet Metal 
2.8 
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1. สร้างไฟล์ Part ใหม่และตั้งระบบหน่วยเป็น มิลลิเมตร ดังที่ได้เคยแสดงในตัวอย่าง
ที่ผ่านมา  

2. เลือกที่   (Feature Manager Design Tree) 
3.  เ รี ยกค าสั่ งที่ เมนูบ าร์  Insert>Reference Geometry> ภายใต้  

Property Manager (1) ใส่ค่า 100 ส าหรับ Offset Distant   (2) ปลดเครื่องหมายหน้า Flip 

Offset   คลิก      
 

 
 

4. เลือกที่ Plane1  (Feature Manager Design Tree) 

 
 

 

5. เรียกค าสั่ง   (Feature tool bar) ภายใต ้Property Manager (1) ใส่

ค่า 30 ส าหรับ Offset Distant    (2) ปลดเครื่องหมายหน้า Flip Offset จะปรากฏ Plane2 
ถูกสร้างขึ้นใหม่ ทางด้านซ้ายใน Feature Manager Design Tree คลิก    
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2.8.2 การ Sketch ส าหรับงาน Sheet Metal 
ข้ันตอนนี้เป็นการสร้าง Sketch ข้ึนบน Plane ที่ได้สร้างไว้แล้วจะได้ตามรูปที่ 2.24 

ค าสั่งที่จะได้เรียนรู้เพิ่มเติมได้แก่ การคัดลอกออกสองด้านด้วยค าสั่ง  การเปลี่ยน 

Sketch ให้เป็นเส้น Construction line การตัดเส้น Sketch ด้วยค าสั่ง  และการ

คัดลอก Sketch ไปยังระนาบใหม่ด้วยค าสั่ง  
 

การ Sketch ปากสี่เหลี่ยมบน Front Plane 

1. คลิกที่  (Feature Manager Design Tree) 

2. เรียกค าสัง่   (Sketch tool bar) Sketch จะถูกเปิดบน Front Plane 
 
3. เรียกค าสั่ง  (Sketch tool bar) Sketch สี่เหลี่ยมโดยใช้จุด 

Origin เป็นจุดศูนย์กลางสี่เหลี่ยมและก าหนดขนาดด้วยค าสัง่   คลิก    
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4. เรียกค าสั่ง  (Sketch tool bar) ใช้จุด Origin เป็นจุดเริ่มต้นของ 
Center line เขียนเส้นตัดผ่านเส้นแนวตั้งด้านขวา กดที่ปุ่ม ESC บนแป้นคีย์บอร์ด เพื่อจบค าสั่ง 

 

 
 

5. เรียกค าสั่ง  (Sketch tool bar) (1) เลือกเส้น Centerline ในข้อ 4 (2) ใส่

ค่า 0.5 ส าหรับ Offset distant  (3) ท าเครื่องหมายหน้า Bi-directional คลิก    
 

 
 
 

6. กดปุ่ม Ctrl บนแป้นคีย์บอร์ดค้างไว้เลือกเส้นสีด าทั้งสองที่เกิดจากการ Offset ใน

ข้อ 5 ท าเครื่องหมายหน้า  ใต้ Options ใน Properties Manager เส้นทั้งสอง
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จะเปลี่ยนเป็น Centerline ขยายส่วนที่เส้นตัดกันด้านปลายโดยเรียกค าสั่ง Zoom to Area   

(View tool bar) คลิก    
 

  
 

7. เรียกค าสั่ง  (1) เลือก  ภายใต้ Options (2) ตัดเส้นบริเวณที่ 
Zoom ในข้อ 6 ทั้งสอง คลิกที่    คลิก Zoom to fit  (View tool bar) 

 

  
 

8. เรียกค าสั่ง Sketch Fillet  (1) ใส่ค่า 10 ส าหรับ Fillet Radius ภายใต้ 

Fillet Parameter (2) เลือกที่มุมทั้งสี่ และคลิก  สองครั้ง 
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9. เลือกเส้น Centerline ทั้ง 5 เส้นภายในสี่เหลี่ยมโดยคลิกที่ 1 ไปยัง 2 และลบ
เส้นทั้ง 5 โดยกดที่ปุ่ม Delete บนแป้นคีย์บอร์ด ตอบ Yes to All ในกล่องข้อความ 

 

  
 

10. คลิกที่  
 

การ Sketch ทรงกลมลดขนาดสี่เหลีย่มบน Plane1 
 

1. คลิกที่ Plane1    (Feature Manager Design Tree) 

2. เรียกค าสัง่  (Sketch tool bar) Sketch จะถูกเปิดบน Plane1  
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3. เรียกค าสัง่ Circle  (Sketch tool bar) กดอกัษร F บนแป้นคีย์บอร์ดเพื่อ

เปลี่ยน View port เป็น Front view คลกิที่ Origin  เป็นจดุศูนย์กลางวงกลมและก าหนด

ขนาด 50 คลิก   
 

 

4. เรียกค าสั่ง  (Sketch tool bar) ใช้จุด Origin  เป็นจุดเริ่มต้น
ของ Center line เขียนเส้นตัดผ่านวงกลม  

5. เรียกค าสั่ง  (Feature Tool bar) (1) ใส่ค่า 0.5 ส าหรับ Offset Distant 

 เลือกเส้น Centerline ที่ Sketch ในข้อ 4 (2) ท าเครื่องหมายหน้า Bi-directional คลิก   
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6. กดปุ่ม Ctrl บนแป้นคีย์บอร์ดค้างไว้เลือกเส้นสีด าทั้งสองที่เกิดจากการ Offset ใน

ข้อ 5 ท าเครื่องหมายหน้า  ใน Properties Manager เส้นทั้งสองจะเปลี่ยนเปน็ 

Centerline คลิกที่  ขยายส่วนที่เส้นตัดกันด้านปลายโดยเรียกค าสั่ง Zoom to Area   
 

  
 

7. เรียกค าสั่ง  ตัดเส้นบริเวณที่ Zoom ในข้อ 6 เลือก  ภายใต้ 

Options ตัดเส้นทั้งสอง คลิกที่   คลิก Zoom to Fit   และคลิกที่  ปรับการแสดง
ภาพเป็น Isometric  

  
 

การคัดลอก Sketch ทรงกลม 
 

1. คลิกที่  (Feature Manager Design Tree) 

2. เรียกค าสัง่ (Sketch tool bar) Sketch จะถูกเปิดบน Plane2  
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3. คลิกที่ Sketch วงกลมที่ได้สร้างในข้ันตอนทีผ่่านมาใน Feature Manager 
Design Tree ปรับการแสดงภาพเป็น Isometric 

 

 
 

4. เรียกค าสั่ง  (Sketch tool bar) Sketch ของวงกลมที่ได้เลือกในข้อ 3 จะ

ถูกคัดลอกไปยัง Plane2 และคลิกที่  
 

 
 

2.8.3 การขึ้นรูปงานแบบ Loft Bends 

การข้ึนรูป Sheet Metal ด้วยค าสั่ง Lofted-Bend  จะท าให้สามารถคลี่ช้ินส่วนน้ัน
ได้ซึ่งจะต่างการการช้ึนรูปช้ินส่วนด้วยค าสั่ง Loft Boss/Base  ผลลัพธ์ที่ได้จะเป็นตามรูป 2.25  
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สร้าง Lofted-Bend เชื่อมต่อระหว่างท่ีสี่เหลี่ยมกับทรงกลม 

1. เรียกค าสัง่ Lofted-Bend   (Sheet Metal Tool bar) เปิด Sheet Metal 
Tool bar โคยคลิกเมาส์ด้านขวาพื้นที่ว่างบน Command Manager เลือก Sheet Metal 

 

 
 

2. เรียกค าสัง่ Zoom   (View Heads-Up) ขยายจุดที่ต้องการก าหนดเป็น 
Profile 

 
 

3. คลิกที่ Zoom   อีกครั้งเพื่อออกจากค าสั่ง คลิกที่ปลายเส้นบริเวณรอยตัด
เพื่อก าหนดเป็น Profile  
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4. เรียกค าสัง่ Zoom to Fit  คลิกที่ Zoom   เพื่อ Zoom ที่ Sketch ของ
วงกลม 

 

 
 

5. คลิกที่ Zoom  อีกครั้งเพื่อออกจากค าสั่ง ก าหนด Profiles  (1) คลิกที่ปลาย

เส้นบริเวณรอยตัดเพื่อก าหนดเป็น Profile (2) คลิกที่   ภายใต้ Faceting 

Options (3) ใส่ค่า 8 ภายใต้ Facet Value คลิก  จะปรากฏ Sheet Metal และ Lofted 
Bends เพิ่มข้ึนใน Feature Manager Design Tree 
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คัดลอก Sketch ส าหรับท า Lofted-Bend ทรงกลม 
 

1. คัดลอก Sketch วงกลมที่ถูกสร้างข้ึนในข้ันตอนที่ 5 (1) คลิกที่ศรหน้า Lofted-
Bend ใน Feature Manager Design Tree (2) คลิกที่ Sketch2 (3) ไปที่เมนูบาร์>Edit>Copy 

 

  
 

2. คลิกที่  ใน Feature Manager Design Tree ไปที่เมนูบาร์>Edit> 
Paste และ Sketch จะถูกคัดลอกไปยงั Plane1 

 

 
 

3. กดปุ่ม Ctrl บนคีย์บอร์ดค้างไว้คลิกที่  Sheet-Metal และ Lofted-Bends ใน 
Feature Manager Design tree เลือก Suppress ในเมนูที่ปรากฏข้ึนมา 
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สร้าง Lofted-Bend ท่ีทรงกลม 

1. เรียกค าสั่ง Lofted-Bend   (Sheet Metal Tool bar)  

2. เรียกค าสั่ง Zoom   (View Heads-Up) ขยายจุดที่ต้องการก าหนดเป็น 
Profile  

 
 

3. คลิก Zoom   อีกครั้งเพื่อออกจากค าสั่ง คลิกที่ปลายเส้นบริเวณรอยตัดเพื่อ
ก าหนดเป็น Profile  

 

 
 

4. เรียกค าสั่ง Zoom   (View Heads-Up) ขยายจุดตัดที่วงกลมด้านปลาย 
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5. คลิก Zoom   อีกครั้งเพื่อออกจากค าสั่ง (1) คลิกที่ปลายเส้นบริเวณรอยตัด

เพื่อก าหนดเป็น Profile (2) คลิกที่  ภายใต้ Faceting Options (3) ใส่ค่า 25 

ภายใต้ Facet Value  คลิก  จะปรากฏ Sheet Metal และ Lofted Bends เพิ่ม ข้ึนใน 
Feature Manager Design Tree 

  
 
6. คลิกที่  Lofted Bends ที่อยู่ในสถานะ Suppress เมื่อเมนูย่อยปรากฏเลือก 

Unsuppress 
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สร้างส่วนปากสี่เหลี่ยม 

1. คัดลอก Sketch (1) คลิกที่ศรหน้า  Lofted-Bend1 (Feature Manager 
Design Tree) (2) คลิกที่  Sketch1 ไปที่เมนูบาร์>Edit>Copy 

 

  
 

2. คลิกที่  ใน Feature Manager Design Tree ไปที่เมนูบาร์>Edit> 
Paste และ Sketch จะถูกสร้างข้ึนใน Feature Manager Design Tree ล าดับสุดท้าย 
 

 
 

3. คลิกที่ Sketch ที่ถูกสร้างในข้อ 2 เรียกค าสั่ง  (1) ใส่ค่า 2 ส าหรับ Depth 

 (2) ปลดเครื่องหมายหน้า Merge result (3) ใส่ค่า 10 ส าหรับ Thickness   ภายใต้ Thin 

Feature คลิก  และ Save  สร้างช่ือไฟล์ Sheet Metal.SLDPRT 
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4. เรียกค าสัง่บันทึกไฟล์ (Standard tool bar) โดยท าตามข้ันตอนดังได้
กล่าวมาแล้วในบทที่ 1 โดยตั้งช่ือไฟล์ในช่อง File name เปน็ Pic-225.SLDPRT  

 
2.8.4 การท าแผ่นคลี่ส าหรับงาน Sheet Metal  

 

ค าสั่ง Flatten จะช่วยให้ผู้ออกแบบทราบขนาดกว้างคูณยาวของแผ่นโลหะที่
ต้องการพับข้ึนรูปโดยไม่ต้องเสียเวลาในการค านวณและยังสามารถ Export ไปท างานร่วมกับ
โปรแกรมอื่นๆได้ 

1. คลิกที่ Flatten (Sheet Metal Tool bar)  
 

 
2. แปลงไฟล์เพื่อน าไปท างานร่วมกับ AutoCAD ไปที่เมนูบาร์>File>Save as ใน

หน้าต่างให้เลือก (1) ชนิดไฟล์เป็น Dwg(*.dwg) ในช่อง Save as type (2) คลิกที่ Save ส าหรับ
การน าไฟล์ไปใช้งานกับโปรแกรม AutoCAD 

 

 
 

3. ท าเครื่องหมายหน้า Sheet Metal และ Geometry คลิก  
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4. จะปรากฏหน้าต่างแสดงภาพผลลัพธ์ คลิก Save 
 

 
 

 
สาระส าคัญ คือ ให้ผู้อ่านเปรียบเทียบรูปทรงระหว่าง ช้ินส่วนที่ ใช้ค าสั่ง Swept 

Boss/Base กับค าสั่ง Loft Boss/Base และ Loft Bend จะพบว่ารูปทรงช้ินส่วนที่เหมาะกับ 
Swept Boss/Base มีลักษณะสมมาตรตลอดเส้นทางการข้ึนรูป แต่รูปทรงของช้ินส่วนที่ข้ึนรูป
ด้วย Loft Boss/Base จะมีลักษณะแตกต่างกันได้ แบบฝึกหัดที่ควรฝึกเพิ่มเติม คือ ข้อที่ 19 และ 
20 

 
 

 
 

มาถึงหัวข้อนี้ผู้อ่านได้ศึกษาเทคนิคและค าสั่งส าหรับการออกแบบ 3 มิติมามากเพียงพอ
ส าหรับการออกแบบรูปทรงต่างๆแล้ว หัวข้อนี้เป็นการประยุกต์เทคนิคที่เคยผ่านมาแล้วเหล่านั้น
เพื่อลดเวลาการออกแบบให้เพิ่มข้ึนไปอีก โดยเมื่อผู้ออกแบบมีความช านาญในการพิจารณา
รูปทรงที่ต้องการออกแบบแล้วก็จะสามารถแยกลักษณะรูปทรงที่มีความคล้ายกันและจัดกลุ่มเข้า
กันไว้ได้ จากนั้นก็ใช้ค าสั่งคัดลอกส่วนที่มีความคล้ายกันเหล่านั้น วิธีการเช่นนี้จะช่วยลดเวลาใน
การออกแบบลงได้มาก 
 

2.9.1 หลักการเลือก Part ท่ีเหมาะสมกับวิธี Linear Pattern 
การใช้เทคนิควิธีการสร้าง Part 3D โดยการคัดลอกเหมาะส าหรับ Part ที่มีลักษณะ

รูปทรงเหมือนกันเช่นในรูปที่ 2.27 จะเห็นได้ว่าช้ันวางช้ันที่ 2 ถึง 4 จะมีลักษณะเหมือนกับช้ัน
วางที่ 1 และชุดขาต้ังทั้ง 4 ก็จะมีลักษณะเหมือนกัน ดังนั้น ช้ินส่วนลักษณะนี้จะมีความเหมาะสม

   หลักการเลือก Part และออกแบบ 3 มิติโดยวิธี Linear Pattern 
2.9 

สรุป 
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ส าหรับการใช้เทคนิค Linear Pattern จากต้นแบบ ตัวอย่างที่จะแสดงได้จากรูปภาพที่ 2.35 ซึ่ง
เป็นภาพประกอบจากแบบฝึกหัดท้ายบทคือ Part หมายเลย 15 ดังรูปที่ 2.28 

 

 
รูปท่ี 2.27 ลักษณะช้ินส่วนที่เหมาะสมกบัการออกแบบ 3 มติิโดยการคัดลอก 

ที่มา : บิรษัทไทยเมทัลเวิล, 2560 
 

 
รูปท่ี 2.28 Part ที่เหมาะสมกับการออกแบบ 3 มิติโดยการคัดลอก 

ที่มา : จังหวัด เจริญสุข, 2560 
 

2.9.2 หลักการออกแบบ Part ส าหรับวิธี Linear Pattern 
1. สร้างส่วนที่เป็นขาต้ังด้านซ้ายด้วยวิธี Swept Boss/Base 
 

 
รูปท่ี 2.29 การใช้ค าสั่ง Swept Boss/Base 

ที่มา : จังหวัด เจริญสุข, 2560 
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2. สร้างส่วนที่เป็นช้ันรองซึ่งจะเป็นต้นแบบในการ Linear Pattern 
 

 
รูปท่ี 2.30 สร้างต้นแบบส าหรับ Linear Pattern 

ที่มา : จังหวัด เจริญสุข, 2560 
 

3. คัดลอกด้วย Linear Pattern 
 

 
รูปท่ี 2.31 คัดลอกด้วย Linear Pattern 

ที่มา : จังหวัด เจริญสุข, 2560 
 

4. สร้างส่วนปิดด้านข้างและด้านบนส าหรับการ Mirror 
 

 
รูปท่ี 2.32 สร้างต้นแบบส าหรับคัดลอกแบบ Mirror 

ที่มา : จังหวัด เจริญสุข, 2560 
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5. คัดลอกต้นแบบด้านซ้ายไปด้านขวาแบบ Mirror 
 

 
รูปท่ี 2.33 คัดลอกแบบ Mirror 

ที่มา : จังหวัด เจริญสุข, 2560 
 

6. สร้างส่วนประกอบเพิม่เติมด้วย Revolve, Extruded Boss/Base และ 
Extruded Cut 

 

 
รูปท่ี 2.34 สร้างส่วนประกอบอื่น 

ที่มา : จังหวัด เจริญสุข, 2560 

 
 

 
จากรูปที่ 2.27 จะเห็นได้ว่าลักษณะช้ันวางทุกๆช้ันจะมีลักษณะเหมือนกันและหากแบ่ง

ออกเป็นส่วนด้านซ้ายและด้านขวาทั้งสองส่วนก็จะเหมือนกันเมื่อพิจารณาได้เ ช่นนี้แล้ว
หมายความว่าสามารถออกแบบเพียงซีกเดียว จากนั้นใช้การคัดลอกแบบLinear Pattern และ 
Mirror ในรูปที่ 2.28 ผู้เขียนได้น าช้ินส่วนมาจากการออกแบบในงานวิจัยตามรูปเต็มระบบรูปที่ 
2.35 โดยแบ่งข้ันตอนการออกแบบไว้ 5 ข้ันตอน  

 

   วิธีการออกแบบ 3 มิติโดยวิธี Linear Pattern 
2.10 
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2.10.1 การสร้าง Part โดยวิธี Linear Pattern 

 

ข้ันตอนน้ีเป็นการใช้ค าสั่งที่เคยใช้งานผ่านมาแล้วอันประกอบด้วย การสร้าง 3D Sketch 
การให้ความสัมพันธ์กับ Sketch การสร้าง Sketch สี่เหลี่ยมด้วยค าสั่ง  การ

ข้ึนรูปด้วยค าสั่ง และคัดลอกแบบแถวตรงด้วยค าสั่ง  จะได้ตามรูปที่ 
2.31 ผู้อ่านสามารถศึกษาตัวอย่างนี้แบบคลิปวีดิโอภาพเคลื่อนไหวควบคู่กับหนังสือได้ที่ 
www.engineeringksu.com/สื่อการสอน/SolidWorks/บทที่2การออกแบบช้ินส่วน 3 มิติ 
(Part)/การออกแบบ 3 มิติโดยวิธี Linear Pattern & Mirror 

 
 

สร้าง Sketch Path ส าหรับขึ้นรูปโดยวิธี Swept Boss/Base 
 

1. สร้างไฟล์ Part ข้ึนใหม่และก าหนดระบบหน่วยเป็น Millimeter ดังแสดงใน
หัวข้อ 2.2  

2. เลือกที่  (Feature Manager Design Tree) 
3. เรียกค าสั่ง  (Sketch tool bar) Sketch จะถูกเปิดที่ Top plane 

4. เรียกค าสั่ง line  (Sketch tool bar) คลิกที่จุด Origin เขียนเส้นข้ึนใน
ทิศทางของแกน Y โดยประมาณ 50 (สามารถเปลี่ยนทิศทางของ Coordinate โดยกดปุ่ม Tab) 
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5. เขียนเส้นต่อไปทางด้านขาวมือในทิศทางแกน X โดยประมาณ 37 
 

 
 

6. เขียนเส้นลงด้านล่างในทิศทางของแกน Y โดยประมาณ 50 กดที่ปุ่ม ESC บน
คีย์บอร์ดเพื่อจบค าสั่ง 

 

 
 

7. ตรวจสอบความถูกต้องของ Sketch โดยการปรับการแสดงภาพให้อยู่ในรูป 
Isometric, Front, Top, Right 
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8. กดปุ่ม Ctrl บนคีย์บอร์ดค้างไว้และเลือกที่เส้นแนวตั้งทางด้านซ้ายและเสน้แนวตัง้

ทางด้านขวาเลือก ภายใต้ Add Relations ใน Properties Manager Design Tree           
คลิกที่  

 

 
 

9. เรียกค าสั่ง   (Sketch tool bar) ก าหนดขนาดเส้นแนวตั้ง 1417 เส้นแนว

นอน 620 คลิกที่  จะปรากฏ 3DSketch1 ใน Feature Manager Design Tree 
 

  
 

 
สร้าง Sketch Profile ส าหรับขึ้นรูปโดยวิธี Swept Boss/Base 
 

1. เลือกที่  (Feature Manager Design Tree) 
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2. เรียกค าสั่ง  (Sketch tool bar) Sketch จะถูกเปิดที่ Top 
plane เขียนรูปสี่เหลี่ยมโดยใช้จุด Origin เป็นจุดศูนย์กลางสี่เหลี่ยม ก าหนดขนาด 50 x 50  

 
 

3. เรียกค าสั่ง    (Sketch tool bar) ใส่ค่า 10 ในช่อง Offset Distant  
คลิกที่เส้นต้นฉบับ คลิกที่      

 

 
 

4. กดปุ่ม Ctrl บนคีย์บอร์ดค้างไว้เลือกทีเ่ส้นทัง้สองและกดปุ่ม Delete บนแป้นคีย์
บอร์ด เส้นทีเ่ลือกจะถูกลบไป 
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5. เรียกค าสัง่ (Sketch tool bar) คลิกทีป่ลายเส้นที่ถูกลบ ปลาย
เส้นจะถูกต่อ 

 

 
 

6. เรียกค าสั่ง  (Sketch tool bar) เลือก  ใต้ Options คลิกที่เสน้

ทั้งด้านบนและด้านขวาเพื่อตัด และคลิกที่  และ  
 

 
 

 
 

ใน Feature Manager Design Tree จะปรากฏ Sketch ข้ึนทั้งหมด 2 Sketch 
ก่อนที่จะสามารถเรียกใช้งานค าสั่ง Swept Boss/Base และให้แน่ใจว่าได้ออกจากโหมด Sketch 
แล้วมิเช่นน้ันจะไม่สามารถเรียกค าสั่ง Swept Boss/Base ได ้

 

 

ข้อสังเกต 
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7. เรียกค าสั่ง  (Feature tool bar) เลือก Sketch สามเหลี่ยม
ด้านล่างส าหรับ Profile และเส้นแนวตั้งส าหรับ Path คลิกที่      

 

  
 
 

การสร้างส่วนท่ีเป็นต้นแบบในการ Linear Pattern 
 

1. คลิกที่ Face ด้านขวา 
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2. เรียกค าสั่ง  (Feature tool bar) Sketch จะถูกเปิดยัง Face ที่ได้เลือก 
ปรับ View port เป็น Front View โดยการคลิกที่แกน Z ของ Coordinate  

 

 
 

3.  เรียกค าสั่ ง   (Sketch tool bar)  Sketch สี่ เหลี่ ยมและ

ก าหนดขนาดด้วยค าสั่ง  
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4. คลิกที่  (1) ใส่ค่า 500 ส าหรับ Depth  (2) คลิก Reverse Direction 
เพื่อเปลี่ยนทิศทาง Extrude คลกิที่   

 

  
 

5. เปิด Sketch (1) คลิกที่ Face เรียกค าสั่ง  (Feature tool bar) Sketch 
จะถูกเปิดยัง Face ที่ได้เลือก (2) ปรับ View port เป็น Right View โดยการคลิกที่แกน X ของ 
Coordinate 
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6.  เรียกค าสั่ ง   (Sketch tool bar)  Sketch สี่ เหลี่ ยมและ

ก าหนดขนาดด้วยค าสั่ง   
 

  
 

7. คลิกที่  ปรับการแสดงภาพให้สามารถเลือก Face ดังรูป (1) เลือก Up to 
Surface ส าหรับ End Condition (2) เลือก Face ส าหรับ Up to Surface คลิกที่   
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การคัดลอกแบบ Linear Pattern 
 

1. เรียกค าสั่ง  (Feature tool bar) (1) เลือกที่ เส้นขอบด้านบน ส าหรับ 

Pattern Direction (2) ใส่ค่า 69 ส าหรับ Spacing    (3) ใส่ค่า 10 ส าหรับ Number of 
Instant   (4) เลือก Boss-Extruded1 ส าหรับ Feature to Pattern ภายใต้ Features and 
Faces คลิกที่   

 

 
 

2.10.2 การสร้าง Part โดยวิธี Mirror 

ข้ันตอนนี้เป็นประยุกต์ใช้ค าสั่ง  แต่เป็นการก าหนดพื้นผิวปลายทางด้วยตัวเลือก 
Up to Surface การให้ความสัมพันธ์กับ Sketch แบบ Collinear และการคัดลอกแบบ 

 จะได้ตามรูปที่  2 .33 ใ ช้ค าสั่ ง  Revolve Boss/Base และ Extruded 
Boss/Base จะได้ตามรูปที่ 2.34 
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สร้างส่วนปิดด้านข้าง 
 

 
 

1. เปิด Sketch (1) คลิกที่ Face  เรียกค าสั่ง  (Feature tool bar) (2) ปรับ 
View port เป็น Right View โดยคลิกที่แกน X ของ Coordinate 

 

 
 

2. เรียกค าสั่ง  (Sketch tool bar) Sketch สี่เหลี่ยมและก าหนด

ขนาดด้วย   คลิกที่   เพื่อจบค าสั่งก าหนดขนาด 
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3. สร้างความสัมพันธ์ระหว่าง Entity โดย (1) กด Ctrl บนแป้นคีย์บอร์ดค้างไว้คลิก
ที่เส้นแนวตั้งด้านขวาของสี่เหลี่ยม (2) คลิกที่ขอบด้านซ้ายของ Face (3)คลิกที่ Collinear ใน 
Properties Manager คลิกที่    

 

   
 

4. คลิกที่  (1) เลือก Up to Surface ส าหรับ End Condition (2) เลือก Face 
ส าหรับ Up to Surface คลิกที่   
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5. เปิด Sketch (1) คลิกที่ Face เรียกค าสั่ง  (Feature tool bar) (2) ปรับ 
View port เป็น Front View โดยคลิกที่แกน Z ของ Coordinate 

 

 
 

6. เรียกค าสั่ง  (Sketch tool bar) Sketch สี่เหลี่ยมและก าหนด

ขนาดด้วย  คลิกที่   เพื่อจบค าสั่งก าหนดขนาด 
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7. สร้างความสัมพันธ์ระหว่าง Entity โดย (1) กด Ctrl บนแป้นคีย์บอร์ดค้างไว้ คลิก
ที่เส้นแนวตั้งด้านซ้ายของสี่เหลี่ยม (2) คลิกที่ขอบด้านซ้ายของ Face (3) คลิกที่ Collinear ใน 
Properties Manager คลิกที่    

 

  
 

8. คลิกที่  (1) คลิกที่ Reverse Direction เพื่อเปลี่ยนทิศทางการ Extrude (2) 
ใส่ค่า 500 ส าหรับ Depth   คลิกที่   
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9. เปิด Sketch (1) คลิกที่ Face เรียกค าสั่ง  (Feature tool bar) (2) ปรับ 
View port เป็น Front View โดยคลิกที่แกน Z ของ Coordinate 

 

 
 

10. เรียกค าสัง่  (Sketch tool bar) Sketch สีเ่หลี่ยมและ

ก าหนดขนาดด้วย  คลิกที่   เพื่อจบค าสัง่ก าหนดขนาด 
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11. สร้างความสมัพันธ์ระหว่าง Entity โดย (1) กด Ctrl บนแป้นคีย์บอร์ดค้างไว้ คลิก
ที่เส้นแนวตั้งด้านขวาของสี่เหลี่ยม (2) คลิกที่ขอบด้านซ้ายของ Face (3) คลิกที่ Collinear ใน 
Properties Manager คลิกที่    

 

    
 

12. คลิกที่  (1) คลิกที่ Reverse Direction เพื่อเปลี่ยนทิศทางการ Extrude 
(2) ใส่ค่า 500 ส าหรับ Depth   คลิกที่   
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สร้างชั้นด้านบน 

1. เปิด Sketch (1) คลิกที่ Face เรียกค าสั่ง  (Feature tool bar) (2) ปรับ 
View port เป็น Top View โดยคลิกที่ แกน Y ของ Coordinate 

 

 
 

2. เรียกค าสั่ง  (Sketch tool bar) Sketch สี่เหลี่ยมโดยก าหนด
จุดที่ 1 เป็นมุมขวาด้านบนและจุดที่ 2 เป็นมุมซ้ายด้านล่าง  
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3. สร้างความสัมพันธ์ระหว่าง Entity โดย (1) กด Ctrl บนแป้นคีย์บอร์ดค้างไว้ คลิก
ที่เส้นแนวตั้งด้านซ้าย (2) คลิกที่เส้นแนวตั้งด้านขวา (3) คลิกที่ Collinear ใน Properties 
Manager คลิกที่    

 

  
 

4. คลิกที่  ใส่ค่า 5 ส าหรับ Depth  ภายใต้ Direction1 คลิกที่    
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คัดลอกแบบ Mirror 
 

เรียกค าสั่ง (Feature tool bar) (1) ก าหนด Mirror Face/Plane (2) 
ก าหนด Solid/Surface Bodies to Mirror ภายใต้ Bodies to Mirror (3) ท าเครื่องหมายหน้า 
Merge solids คลิกที่    

 

  
 

สร้างอุปกรณ์แสดงสถานะการผลิตไฟฟ้าจาก Generator 
 

1. คลิกที่ Face ด้านบนและเรียกค าสั่ง  (Sketch tool bar) เขียนเส้น 
Centerline ข้ึนในแนวตั้งโดยเริ่มที่จุด Origin (สามารถปรับทิศทางของ Origin โดยกดที่ปุ่ม 
Tab)  กด Esc เพื่อจบค าสั่งเขียนเส้น 
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2. ก าหนดต าแหน่งเส้น Centerline คลิกที่  และคลิกที่  
 

 
 

3. เรียกค าสั่ง  (Feature tool bar) (1) คลิกที่เส้น Centerline ส าหรับ 
First Reference ( 2 )  คลิ กที่  Front ( Feature Manager Design Tree Fly Out)  ส า หรั บ 
Second Reference คลิกที่     
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4. คลิกที่ Plane1 ที่ได้สร้างในข้อ 3 เรียกค าสั่ง  (Sketch tool bar) Sketch 
จะถูกเปิดบน Plane1 ปรับ View port เป็น Right View  

 

 
 

5. เรียกค าสั่ง (Sketch tool bar) (1) คลิกที่ Centerline (2) ใส่ค่า 10 ส าหรบั 
Offset Distant ภายใต้ Parameters (3) ปรับทิศทางการ Offset โดยท าเครื่องหมายหน้า 
Reverse คลิกที่     
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6. เรียกค าสั่ง  (Sketch tool bar)  (1) ก าหนดจุดศูนย์กลาง (2)  
จุดเริ่มต้น (3) จุดสุดท้ายของส่วนโค้งโดยการประมาณ  

 
 

7. เรียกค าสั่ง  (Sketch tool bar) เลือก   ภายใต้ Options คลิก
ที่เส้นที่อยู่ตรงกลางระหว่างส่วนโค้ง คลิกที่     

 
 

8. เรียกค าสั่ง  (Sketch tool bar) ก าหนดขนาดเส้นแนวตั้ง 140 คลิกที่     
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9. เรียกค าสั่ง  (Feature tool bar) (1) เลือกเส้นความยาว 140 ส าหรับ 

Axis of Revolution (2) ใส่ค่า 10 ส าหรับ Direction1 Thickness   ภายใต้ Thin Feature 
คลิกที่      

 
 

สร้างอุปกรณ์วัดค่าแรงดันและกระแสไฟฟ้า 
 

1. คลิกที่ Face และเรียกค าสั่ง   (Sketch tool bar) Sketch จะถูกเปิดบน 
Face ที่เลือก และปรับ View port เป็น Front View โดยกดที่อักษร F บนแป้นคีย์บอร์ด 
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2.  เรียกค าสั่ ง   (Sketch tool bar)  Sketch สี่ เหลี่ ยม (1) 
ก าหนด Entity ขอบบนเป็นจุดเริ่มต้นสี่เหลี่ยม และก าหนดขนาดของสี่เหลี่ยม 

 

 
 

3. เรียกค าสั่ง  (Sketch tool bar) ใช้จุดกึ่งกลางของสี่เหลี่ยมเป็น
จุดเริ่มต้นของ Centerline เขียนเส้นข้ึนในแนวตั้งและก าหนดขนาด 

 

 
 

4. เรียกค าสั่ง  (Sketch tool bar) ใช้ปลายเส้น Centerline เป็นจุด
ศูนย์กลางวงกลมเขียนวงกลมเส้นผ่านศูนย์กลาง 60 
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5. เรียกค าสั่ง  (Sketch tool bar) ตัดเส้นที่ไม่ต้องการออก คลิกที่    

 
 

6. เรียกค าสั่ง  (Feature tool bar) ปรับการแสดงภาพเปน็ Isometric view 
โดยกดอักษรตัว I ที่แป้นคีย์บอร์ด (1) ใส่ค่า 30 ส าหรับ Depth  (2) คลิกที่  Reverse 
Direction เพื่อเปลี่ยนทิศทางการ Extruded คลิกที่    
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คัดลอกแบบ Linear Pattern 

 

1. เรียกค าสัง่   (Feature tool bar) (1) ก าหนดทิศทางการคัดลองโดยคลิกที่
เส้นขอบผิวบนส าหรับ Pattern Direction (2) คลิกที่ Reverse Direction เพื่อเปลี่ยนทิศ
ทางการคัดลอก (3) ใส่ค่า 70 ส าหรับ Spacing  (4) ใส่ค่า 4 ส าหรบั Number of Instant 

  (5) คลิกที่ Boss-Extrude ส าหรับ Feature and Faces คลิกที่    
 

 
 

2. เรียกค าสั่ง   (Feature tool bar) (1) คลิกที่ เส้นขอบส าหรับ Pattern 

Direction (2) ใส่ค่า 150 ส าหรับ Spacing  (3) ใส่ค่า 2 ส าหรับ Number of Instant   
(4) คลิกที่ Revolve-Thin1 ส าหรับ Feature and Face คลิกที่    
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เจาะพ้ืนรองส าหรับยึด Generator 
 

1. เลือกที่ Face ด้านบน เรียกค าสั่ง   (Feature tool bar) Sketch จะถูกเปิด
ที่ Face ด้านบน ปรับ View port เป็น Top view 

2. เรียกค าสั่ง  (Sketch tool bar) Sketch ที่ขอบด้านซ้ายและ
ก าหนดขนาด คลิกที่      

 
 

3. คลิกที่  ใส่ค่า 10 ส าหรับ Depth  ภายใต้ Direction1 คลิกที่      
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4. เรียกค าสัง่บันทึกไฟล์ (Standard tool bar) โดยท าตามข้ันตอนดังได้
กล่าวมาแล้วในบทที่ 1 โดยตั้งช่ือไฟล์ในช่อง File name เปน็ Pic-234.SLDPRT  

 
รูปท่ี 2.35 การออกแบบเครื่องยนตส์เตอรล์ิงแบบแกมม่าส าหรบัใช้ประกอบ

แบบฝกึหัดท้ายบทที่ 2 และเป็นช้ินส่วนส าหรับการประกอบ (Assembly) บทที่ 3 
ที่มา : จังหวัด เจริญสุข, 2560 
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  ค าถามที่ใช้ค าว่า “ให้อธิบาย” หมายถึง เป็นการเขียนอธิบายสรุปความเข้าใจ ค าถามที่
ใช้ค าว่า “ให้แสดง” หมายถึง ให้แสดงวิธีการเป็นล าดับข้ันตอนดังตัวอย่างที่ได้แสดงผ่านมาแลว้ 
 

1. ให้อธิบายหลักการเลือก Part ที่เหมาะสมกับวิธี Extruded Boss/Base 
2. ให้อธิบายหลักในการก าหนดข้ันตอนเขียน Part โดยวิธี Extruded Boss/Base 
3. ให้แสดงข้ันตอนการออกแบบช้ินส่วนด้วยวิธี Extruded Boss/Base ตามตัวอย่างที่

ได้แสดงในหัวข้อ 2.2 โดยให้ขนาดช้ินส่วนมีขนาดเพิ่มข้ึนมากกว่าตัวอย่าง 1.5 เท่า และให้แยก
แสดงเป็นข้ันตอนตามหัวข้อดังต่อไปนี้ 

3.1. ให้แสดงข้ันตอนการเขียนรูปทรงตันด้วย Extruded Boss/Base   
3.2. ให้แสดงข้ันตอนการลบมุมด้วย Fillet 
3.3. ให้แสดงข้ันตอนการเจาะรูด้วย Hole Wizard 

3.4. ให้แสดงข้ันตอนการคัดลอกแบบทรงกลมด้วย Circular Pattern 

4. ให้แสดงข้ันตอนการออกแบบช้ินส่วนด้วยวิธี Extruded Boss/Base ตามตัวอย่างที่
ได้แสดงในหัวข้อ 2.2 โดยใช้แบบใต้ข้อ 4 และให้อธิบายเป็นข้ันตอนย่อยตามแบบฝึกหัดย่อยข้อที ่
3.1 ถึง 3.4 ในแบบที่ไม่ได้ก าหนดขนาดให้ออกแบบตามความเหมาะสม 
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5. ให้อธิบายการข้ึนรูปทรงตันจากตัวอย่างในหัวข้อ 2.2.1 สามารถลดข้ันตอนจาก
ทั้งหมด 7 ข้ันตอนให้ลดน้อยลงได้หรือไม่เพราะเหตุใด 

6. ให้แสดงวิธีการท าส่วนโค้งแบบ Variable Size Fillet ดังแสดงในหัวข้อ 2.2.2 โดย
ก าหนดค่า V1 R=1.5mm, V2 R=4.5mm, V3 R=1.5mm, V4 R=4.5mm 

7. ให้แสดงวิธีการเจาะรูด้วยค าสั่ง Hold Wizard ดังแสดงในหัวข้อ 2.2.3 โดยก านหนด 
Hold Type เป็น Countersink ก าหนด Size เป็น M10   

8. ให้แสดงวิธีการคัดลอกแบบทรงกลมด้วย Circular Pattern โดยก าหนด Number 
Instant เท่ากับ 20 

9. ให้อธิบายหลักการเลือก Part ที่เหมาะสมกับวิธีb Revolved Boss/Base 
10. ให้อธิบายหลักในการก าหนดข้ันตอนเขียน Part โดย วิธี Revolved Boss/Base 
11. ให้แสดงการออกแบบช้ินส่วนด้วยวิธี Revolved Boss/Base ตามตัวอย่างที่ได้แสดง

ในหัวข้อ 2.4 โดยให้ขนาดของช้ินส่วนมีขนาดเพิ่มข้ึนมากกว่าตัวอย่าง 1.5 เท่า โดยให้แยกแสดง
วิธีการเป็นข้ันตอนตามหัวข้อย่อยดังต่อไปนี้ 

11.1. ให้แสดงข้ันตอนการ Sketch 2 มิติส าหรับ Revolved Boss/Base  
11.2. ให้แสดงข้ันตอนการข้ึนรูป 3 มิติโดย Revolved Boss/Base 
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11.3. ให้ แสดง ข้ันตอนการ ข้ึนรูปทรงตันแบบ Mid Plane ด้ วย  Extruded 
Boss/Base 

11.4. ให้แสดงข้ันตอนการตัดทรงตันแบบ Mid Plane ด้วย Extruded Cut 
11.5. ให้แสดงข้ันตอนการใช้สมการ Equation ช่วยในการคัดลอกแบบทรงกลม 

Circular Pattern 
12. ให้แสดงการออกแบบช้ินส่วนด้วยวิธี Revolved Boss/Baseตามตัวอย่างที่ได้แสดง

ในหัวข้อ 2.4 โดยใช้แบบ และให้แยกอธิบายเป็นข้ันตอนตามแบบฝึกหัดย่อยข้อที่ 11.1 ถึง 11.5 
โดยออกแบบขนาดตามความเหมาะสม 

 
 

13. ให้อธิบายหลักการเลือก Part ที่เหมาะสมกับวิธี Swept Boss/Base 
14. ให้อธิบายหลักในการก าหนดข้ันตอนเขียน Part โดยใช้วิธี Swept Boss/Base 
15. ให้แสดงการออกแบบช้ินส่วนด้วยวิธี Swept Boss/Base ตามตัวอย่างที่ได้แสดงใน

หัวข้อ 2.6 โดยให้ขนาดของช้ินส่วนมีขนาดเพิ่มข้ึนมากกว่าตัวอย่าง 1.5 เท่า โดยให้แยกแสดง
วิธีการเป็นข้ันตอนตามหัวข้อย่อยดังต่อไปนี้ 

15.1. ให้แสดง ข้ันตอนการ Sketch 2 มิติส าหรับการ ข้ึนรูป โดยวิ ธี  Swept 
Boss/Base 

15.2. ให้แสดงข้ันตอนการข้ึนรูป 3 มิติโดยวิธี Swept Boss/Base 
15.3. ให้แสดงข้ันตอนการสร้าง Plane 
15.4. ให้แสดงข้ันตอนการข้ึนรูป 3 มิติโดย Loft 
15.5. ให้แสดงข้ันตอนการคว้านโดยใช้ Shell 

16. ให้แสดงการออกแบบช้ินส่วนด้วยวิธี Swept Boss/Base ตามตัวอย่างที่ได้แสดงใน
หัวข้อ 2.6 โดยใช้แบบ และให้แยกอธิบายเป็นข้ันตอนตามแบบฝึกหัดย่อยข้อที่ 15.1 ถึง 15.5 
โดยในแบบที่ไม่ได้ก าหนดขนาดให้ออกแบบตามความเหมาะสม 
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17. ให้อธิบายหลักการเลือก Part ที่เหมาะสมกับวิธีการโลหะบาง (Sheet Metal) 
18. ให้อธิบายหลักในการก าหนดข้ันตอนเขียน Part ส าหรับงานโลหะบาง Sheet Metal 
19. ให้แสดงการออกแบบช้ินส่วนด้วยวิธี Sheet Metal ตามตัวอย่างที่ได้แสดงในหัวข้อ 

2.8 โดยให้ขนาดของช้ินส่วนมีขนาดเพิ่มข้ึนมากกว่าตัวอย่าง 1.5 เท่า โดยให้แสดงวิธีการเป็น
ข้ันตอนตามหัวข้อย่อยดังต่อไปนี้ 

19.1. ให้แสดงข้ันตอนการสร้าง Plane 
19.2. ให้แสดงการ Sketch ส าหรบังาน Sheet Metal 
19.3. ให้แสดงการข้ึนรปูงานแบบ Loft Bends 
19.4. ให้แสดงการท าแผ่นคลีส่ าหรับข้ึนรูปงาน Sheet Metal  

20. ให้แสดงการออกแบบช้ินส่วนด้วยวิธี Sheet Metal ตามตัวอย่างที่ได้แสดงในหัวข้อ 
2.8 ใช้แบบ โดยให้แยกอธิบายเป็นข้ันตอนตามแบบฝึกหัดย่อยข้อที่ 19.1 ถึง 19.4 ให้ก าหนดค่า 
Number of Bends เท่ากับ 8 และค่าความหนา (Thickness) เท่ากับ 2 ส่วนที่ในแบบไม่ได้
ก าหนดให้ออกแบบค่าตามความเหมาะสม 
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21. ให้อธิบายหลักการเลือก Part ที่เหมาะสมกับวิธีการคัดลอกแบบเชิงเส้น (Linear 
Pattern) 

22. ให้อธิบายหลักในการก าหนดข้ันตอนเขียน Part ด้วยวิธีการคัดลอกแบบเชิงเส้น 
23. ให้แสดงวิธีการออกแบบช้ินส่วนด้วยวิธีการคัดลอกตามตัวอย่างที่ได้แสดงในหัวข้อ 

2.10 โดยให้ขนาดของช้ินส่วนมีขนาดเพิ่มขึ้นมากกว่าตัวอย่าง 1.5 เท่า โดยให้แยกแสดงวิธีการ
เป็นข้ันตอนตามหัวข้อย่อยดังต่อไปนี้ 

23.1. ให้แสดงข้ันตอนการคัดลอกแบบ Linear pattern 
23.2. ให้แสดงข้ันตอนการคัดลอกแบบ Mirror 

24. ให้แสดงการออกแบบช้ินส่วนด้วยวิธีการคัดลอกตามตัวอย่างที่ได้แสดงในหัวข้อ 
2.10 ใช้แบบดงัรูปภายใต้ข้อ 24 โดยให้แยกอธิบายเป็นข้ันตอนตามแบบฝึกหัดย่อยข้อที่ 23.1 ถึง 
23.2 
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25. ให้แสดงการออกแบบ Part ในรูปที่ 2.35 หมายเลขที่ 13 ด้วยการประยุกต์วิธี  
Extruded Boss/Base โดยให้ออกแบบขนาดตามความเหมาะสม 

26. ให้แสดงการออกแบบ Part ในรูปที่ 2.35 หมายเลขที่ 8 ด้วยการประยุกต์วิธี 
Revolved Boss/Base โดยให้ออกแบบขนาดตามความเหมาะสม 

27. ให้แสดงการออกแบบ Part ในรูปที่ 2.35 หมายเลขที่ 7 ด้วยการประยุกต์วิธี Swept 
Boss/Base โดยให้ออกแบบขนาดตามความเหมาะสม 

28. ให้แสดงการออกแบบ Part ในรูปที่ 2.35 หมายเลขที่ 2 ด้วยการประยุกต์วิธี Loft 
Boss/Base โดยให้ออกแบบขนาดตามความเหมาะสมและอธิบายเปรียบเทียบกับการใช้วิธี  
Revolved Boss/Base จะให้ความยากง่ายและข้ันตอนในการออกแบบแตกต่างกันอย่างไร 
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29. จากรูปภายใต้แบบฝึกหัดข้อ 29 นี้ขอให้ออกแบบช้ินส่วนแต่ละช้ินโดยก าหนดขนาด
ให้เหมาะสมโดยใช้วิธีทั้งหมดที่ได้ศึกษาในบทที่ 2 นี้ 

 
 
 
 

 
 
 
 
 
 


